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A. Introduction

About this Tutorial Collection

According to Article 76, coastal states can - under certain geological conditions - extend their juridical
Continental Shelf and thus gain marine sovereignty rights beyond the 200-nautical-mile limit of the Exclusive
Economic Zone (EEZ). Submissions for an extended Continental Shelf need to be filed directly with the
Commission on the Limits of the Continental Shelf (CLCS) and must contain detailed marine geo-scientific data
describing e. g. the shape of the continental margin, the location of the foot of the continental slope and the
sediment thickness. 

This tutorial collection will guide you through the process of analyzing different marine geo-scientific data and
producing the documentation needed for an extended continental shelf submission. The order of the tutorials is
more or less describing the suggested order in which a real submission would be done using the UNCLOS
article 76 functionality in Geocap. 

In this set of tutorials you will learn how to:

Use Geocap in general
Create a new project
Import data
Calculated different distance lines and constraint lines.
Do analysis and set foot of slope points
Calculate Hedberg points 
Interpret seismic data
Depth convert interpretations and calculate sediment thickness 
Calculate Gardiner points
Generate a final outer limit line
+++

The Atlantis Project

The Atlantis project will be used as an example project in this tutorial, but you should also be able to follow the
tutorial using your own data.The Kingdom of Atlantis is an imaginary state which has started to work on their
extended continental shelf submission. Using this tutorial collection we are going to finalize the analysis and
complete the Atlantis project using the functionality in Geocap Shelf.

The continental shelf of Atlantis

<pagebreak>
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UNCLOS Article 76

Below you will find the full definition of the continental shelf as stated in UNCLOS Article 76.

Definition of the continental shelf

The continental shelf of a coastal State comprises the seabed and subsoil of the submarine areas that
extend beyond its territorial sea throughout the natural prolongation of its land territory to the outer edge
of the continental margin, or to a distance of 200 nautical miles from the baselines from which the breadth
of the territorial sea is measured where the outer edge of the continental margin does not extend up to
that distance.
 
The continental shelf of a coastal State shall not extend beyond the limits provided for in paragraphs 4
to 6.
 
The continental margin comprises the submerged prolongation of the land mass of the coastal State, and
consists of the seabed and subsoil of the shelf, the slope and the rise. It does not include the deep ocean
floor with its oceanic ridges or the subsoil thereof.
 
(a) For the purposes of this Convention, the coastal State shall establish the outer edge of the continental
margin wherever the margin extends beyond 200 nautical miles from the baselines from which the
breadth of the territorial sea is measured, by either:

a line delineated in accordance with paragraph 7 by reference to the outermost fixed points
at each of which the thickness of sedimentary rocks is at least 1 per cent of the shortest
distance from such point to the foot of the continental slope; or
a line delineated in accordance with paragraph 7 by reference to fixed points not more than
60 nautical miles from the foot of the continental slope.

(b) In the absence of evidence to the contrary, the foot of the continental slope shall be determined
as the point of maximum change in the gradient at its base. 
 

The fixed points comprising the line of the outer limits of the continental shelf on the seabed, drawn in
accordance with paragraph 4 (a)(i) and (ii), either shall not exceed 350 nautical miles from the baselines
from which the breadth of the territorial sea is measured or shall not exceed 100 nautical miles from the
2,500 metre isobath, which is a line connecting the depth of 2,500 metres.
 
Notwithstanding the provisions of paragraph 5, on submarine ridges, the outer limit of the continental shelf
shall not exceed 350 nautical miles from the baselines from which the breadth of the territorial sea is
measured. This paragraph does not apply to submarine elevations that are natural components of the
continental margin, such as its plateaux, rises, caps, banks and spurs.
 
The coastal State shall delineate the outer limits of its continental shelf, where that shelf extends beyond
200 nautical miles from the baselines from which the breadth of the territorial sea is measured, by straight
lines not exceeding 60 nautical miles in length, connecting fixed points, defined by coordinates of latitude
and longitude.
 
Information on the limits of the continental shelf beyond 200 nautical miles from the baselines from which
the breadth of the territorial sea is measured shall be submitted by the coastal State to the Commission
on the Limits of the Continental Shelf set up under Annex II on the basis of equitable geographical
representation. The Commission shall make recommendations to coastal States on matters related to the
establishment of the outer limits of their continental shelf. The limits of the shelf established by a coastal
State on the basis of these recommendations shall be final and binding.
 
The provisions of this article are without prejudice to the question of delimitation of the continental shelf
between States with opposite or adjacent coasts.
 
The coastal State shall deposit with the Secretary-General of the United Nations charts and relevant
information, including geodetic data, permanently describing the outer limits of its continental shelf. The
Secretary-General shall give due publicity thereto.
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B. Getting Started with Shelf

Introduction

Geocap is a software for mapping and modeling geoscientific data, designed with focus on interactivity and
flexible control of visualization and manipulation. Geocap is operated through projects. The project "holds" the
data in a folder-like structure, similar to Windows "File Explorer". All datasets are "children" of either a folder or
another dataset. Geocap offers different project templates, giving you a pre-defined folder structure that fits your
workflow for a specific type of work. In this tutorial collection we are going to use the Shelf/UNCLOS project
template.

Data visualization and manipulation is operated through commands. Commands can be used to display datasets
in the graphics window, manipulate existing datasets or to generate new datasets. The Geocap Shelf module
offers a range of commands with tailor made article 76 functionality.These commands are available in a Toolbox
or if you right click a dataset or folder in the project.

All the project data is visualized in the graphics window and by using the mouse it is possible to pan, zoom,
rotate, spin, scale z-axis and so on.

This section will guide you through the basics of opening a project, explore and display the project data and
navigate in the graphics window.

Exercises

Start Geocap
Set working directory and auto save
Open the Atlantis project
Explore the project folder structure
Display data
Navigate using the mouse

Starting Geocap

Exercise

Start Geocap

On your start menu click Start > All programs > Geocap > Geocap 7.x.x - 64 > Geocap 7.x.x - 64

Initial Setup

Geocap comes with a range of settings which can modified to make it easier to work with. One of these settings
is the working directory which is the folder Geocap will open every time you browse for something. We will now
set this directory and we will also turn on auto save.

Exercise

Set working directory and auto save

Click Tools > Options
Click the  icon for thebrowse  Working Directory.
Select the folder and click Geocap1  Select folder
Click on Projects
Check the box Automatically save all projects at regular time intervals
Set the  to Time interval 5
Click OK

-
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Geocap Project

The Atlantis project is built using the UNCLOS project template. This template consists of four main top level
folders; Maritime lines, Seabed, Sediment data and Outer limit. The maritime lines folder will hold all the data
that has no reference to depth or is located at the sea surface. The Seabed folder will hold all the data located at
the seabed, like bathymetric profiles, foot of slope points and so on. The Sediment data folder will hold all the
subsurface data like seismic, interpretations, velocities, sediment profiles etc. The Outer limit folder will hold all
datasets which is used to construct the outer limit. We are now going to open the Atlantis project and look closer
at this project structure.

Exercise

Open the Atlantis project

Click File > Open > Project
Browse to the location of the Atlantis project ( )Geocap1/Projects/Atlantis_3/db
Select the  file and click .Atlantis.db Open

Pressing the small triangles (or '+' in other Windows versions) to the left of a folder will display the folder's
contents. Datasets and folders are organized very similarly to a file tree structure. A folder can contain other
folders, or datasets.

In the next exercise we are going to explore how the Atlantis project is structured. Taking notice of how folders
and datasets are organized. Datasets and folders can be cut, copied, pasted, renamed and deleted. This is
performed from the popup menu which appears when right-clicking a dataset. The right click popup menu also
contains commands which may be executed on the datasets.

Exercise

Explore the project folder structure

Expand the different folders and observe the sub folders and datasets
Right click on folders and datasets and look at the right-click menus.

-

Tip
Next time you can open the project by going to .File > Recent Projects

Note that there are two "modes" of the project view. Switch between these two by clicking on the tabs; Li
and .  view sorts folder content into a separate window, while  view sorts everything intost Tree List Tree

the tree itself.

A Geocap project is stored in a folder on your computer. The project consist of a   file, which".db"
contains information about the project tree, and several files which contain the data sets. You should let
Geocap manage the files in the project folder and should not store other files in this folder.

If you want to make a backup of your projects, or if you want to exchange Geocap projects with other
Geocap users you may zip the project folder with all the underlaying datasets into one file. This is
convenient for sending e.g. to .support@geocap.no
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Displaying Data

By right clicking a dataset a range of different visualization commands is made available. For each type of
dataset Geocap will have a default command. This is the command which will be used when ticking the
checkbox next to a dataset. We are now going to display the different datasets in the project using the default
command.

Exercise

Display data

In the folder tick the checkbox next to the seabed surface.2. Seabed / Grids  atlantis 
Right click the  and select . This will make the displayatlantis seabed surface Zoom to Data
window center the graphics window around the dataset.
In the folder  tick the checkbox next to 1. Maritime Lines / Coast lines The Kingdom Of

coast line.Atlantis 
In the folder  tick the checkbox next to base1. Maritime Lines / Base lines Baseline_Atlantis 
line.
In the folder  tick the checkbox next to li1. Maritime Lines / 12 lines Baseline_Atlantis + 12M 
mit line.
In the folder  tick the checkbox next to all the2. Seabed / Bathymetric Profiles / North Sea
bathymetric profiles

Navigating in the 3D window

Now that we have displayed some of our data we can start navigating around the Atlantis continental shelf. Geoc
ap is best operated using a three-button mouse with a wheel, see picture below. A two-button mouse or using
the Touch-pad is possible but not recommended. Navigating in the 3D graphics window is done by pressing one
of the mouse buttons while the cursor is in the graphics window, and moving the mouse while keeping the button
pressed.

Rotate - Press left mouse button + move
Pan - Press middle mouse button (wheel) + move or Shift + left mouse button + move
Zoom - Press right mouse button + move
Scale Z - Scroll mouse wheel 
Spin - Ctrl + press left mouse button + move

The mouse buttons

Note that by checking and unchecking the first level folder 1. Maritime Lines, or 2. Seabed all datasets
displayed under this folder are shown and hidden.
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Exercise

Navigate using the mouse

 in close to one of the bathymetric profiles displayed by press  andZoom right mouse button
moving the mouse upwards.

 along the seabed surface by pressing the  (wheel) and moving thePan middle mouse button
mouse in any direction.
Zoom out again by press right mouse button and moving the mouse downwards.

 the displayed data by pressing the  and moving the mouse.Rotate left mouse button
 the data by holding down  on your keyboard, pressing the  andSpin Ctrl  left mouse button

moving the mouse.
Now try to increase the  by  upwards.z-scale scrolling the mouse wheel
Move around the 3D model an practice these elements for a few minutes.

Tip
The focal point is the center of the display and the point of rotation. Change the focal point by
positioning the mouse cursor on a desired point in the display window and press the  key onX
the keyboard.
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C. Generation of Distance Lines

Introduction

Calculating distances can be done in many different ways. Geocap uses algorithms that take into account the
curvature of the Earth which provides for better accuracy and is in accordance with the scientific and technical
guidelines established by the Commission on the Limits of the Continental Shelf (CLCS) for UNCLOS Article 76.
Any distance can be calculated in Geocap but the main ones are:

12M Territorial Seas.
24M Contiguous Zones.
200M Exclusive Economic Zones
60M Formula Lines.
100M Constraint Lines.
350M Constraint Lines.

 

Exercises

Generate the 200M line
Display base point connection polygon
Check Table View for the 200M line
Generate 350M line
Use the Distance Calculation tool

200M Line Generation

Exercise

Generate the 200M line

In the folder  right-click  and select the1. Maritime lines / Base lines Baseline_Atlantis
command Generate 200M line...
Make sure that  is checked. The menu should lookGenerate base point connection polygon
exactly as the screenshot below.
Click .Execute
The new line should now be available under . Click .1. Maritime Lines/200M Lines OK
Click to close the menu and keep the settings.OK 
In the folder 1. Maritime lines / 200M lines tick the box next to the Baseline_Atlantis + 200M
dataset to display it.

Generate 200M line menu

Note that our Maritime Zones plugin extends the Shelf package with additional capabilities for calculating
maritime zones. It works directly with ArcGIS feature classes and can calculate any maritime zone from
both normal and straight baselines. The calculation also extracts critical points for each zone and store
them in a feature class. Read more about the: Maritime Zones plugin

https://geocap.atlassian.net/wiki/display/ug/Maritime+Zones+plugin
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Note that not all points on the baseline will contribute to the generation of the  line. To visualize which200M
points on the baseline that contributes to the 200M we can display the . base point connection polygon

Exercise

Display base point connection polygon

In the folder 1. Maritime lines / Base lines right-click Baseline_Atlantis and click Display
Points
In the folder 1. Maritime lines / 200M lines tick the box next to the Baseline_Atlantis + 200M
Connection Polygon dataset to display it.

right clickIn the folder 1. Maritime lines / 200M lines  Baseline_Atlantis + 200M Connection
and clickPolygon  Display Points.

Notice how the polygons points back to the critical points on your baseline (see image
below).
Toggle the display between polygon mode and wire mode with the W and S keys.

Information on point spacing

The arc on an "envelope of arcs" in reality consist of a series of short chords. The point spacing
represent the length of these chords. 
In the image below you will see that a larger area will be lost (outside blue chords) if we double the point
spacing on the arc.

It is recommended that the chord lengths (point spacing) are determined such that the distance between
the arc and the chord never exceeds 1 meter. Below you will find a table of distance lines and the
corresponding point spacing which fulfills this recommendation.

Distance line (M) Point spacing (M)

3 Nautical Miles 0.1 Nautical Miles

12 Nautical Miles 0.2 Nautical Miles

60 Nautical Miles 0.5 Nautical Miles

200 Nautical Miles 1.0 Nautical Miles

350 Nautical Miles 1.0 Nautical Miles
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200M line with critical points on baseline in blue

Exercise

Check Table View for the 200M line

In the folder 1. Maritime lines / 200M lines right click Baseline_Atlantis + 200M and click Ta
ble View.
Observe the columns, ,  and . This tellsBase Line  Base Line Index Second Base Line Index
you which baseline and which point on the baseline that contributed to the point on the 200M
line.
Scroll down and select a point that has values in both   and Base Line Index Second Base

If  is checked the point should be highlighted in theLine Index.  Display marked points
graphics window.
Observe that this is the crossing points between two arcs in an envelope of arcs calculation
(equidistance point). That is why it is referring to two base points.
Click  to close Close Table View

350M Line Generation

Exercise

Generate 350M line

In the folder  right-click  and select the1. Maritime lines / Base lines Baseline_Atlantis
command Generate 350M line...
Keep the default settings and click .Execute
The new line should now be available under . Click .1. Maritime Lines / 350M Lines OK
Click to close the menu and keep the settings.OK 
In the folder  tick the box next to the 1. Maritime lines / 350M lines Baseline_Atlantis + 350M
dataset to display it.

-

It is possible to store the points which contributes to the 200M line as a separate dataset in your project.
This can be done by checking the  on the  menuExtract critical points Generate 200M line...
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To verify that the distances are correct we can use the Distance Calculations tool.

Exercise

Use the Distance Calculation tool

Open the tool from .Tools > Distance Calculations
Click to put Geocap in 2DYES 
Select coordinate system (all values 0)Mercator 
For distance calculation method, select . (  calculates in theVincenty calculation Flat earth
metric values of the projection)
Select Distance unit: nautical mile
To measure the distance between two points, press  on the keyboard to snap to themj .
The distance is displayed in the lower part of the panel. Notice that vertical, horizontal and
total distance is measured and that lat/long of the select point is listed.
Click the  to close the menuX

Click  to get back into 3D view.
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D. Bathymetry

Introduction

The use of bathymetry is a very central element when working with the determination of the extension of the
continental shelf according to UNCLOS Article 76. It is relevant both for the depth constraint (2500m depth
+100M) and the determination of the foot of the continental slope. 

In Geocap bathymetry can have several different forms:

Singlebeam data may be imported as bathymetric profiles.
Multibeam soundings or other spread point data with depth measurements can also be imported.  In order
to use the foot of slope analysis tool on point data, the dataset must be gridded first. This can be done in
Geocap.
Grids may be imported directly into Geocap. Geocap supports import of several different grid file formats.
Most Shelf projects will consist of a low resolution grid (i.e Etopo or SRTM) covering the whole area of
interest and then smaller high resolution grids from multibeam data.

The Etopo or SRTM grids will  be accepted by the Commission as a basis for your foot of slope points.not
However once you have imported the grid you will be able to see the shape of the seafloor, and in particular the
approximate position of the Foot of Slope or base of slope region.

Exercises

Generate the 2500m isobath from a Seabed Surface
Edit the generated 2500m isobath
Set geodetic metadata
Generate 2500m isobath + 100M constraint line
Generate a bathymetric profile from a grid
Generate more bathymetric profiles in the East Sea area
Group your bathymetric profiles into a folder
Rename your bathymetric profiles

2500m isobath + 100M constraint

Computing the 2500m isobaths is necessary in order to determine the Depth constraint in UNCLOS Article 76,
which is the 2500m isobaths plus 100 nautical miles.  The 2500m isobaths can be generated based on
bathymetry grids or on bathymetric profiles (from single beam bathymetry). The only ones that can be used for
an actual submission to the CLCS are 2500m isobath points generated from real bathymetry data.  For a grid,
the resulting 2500m isobath will be a contour line.  A bathymetric profile will produce one or more points
wherever the profile value is 2500m.

Exercise

Generate the 2500m isobath from a Seabed Surface

In the folder right click the dataset and select 2. Seabed / Grids atlantis Generate 2500m
 Isobath.

The command will generate a new dataset. Click OK.
In the folder  check the box next to the dataset 2. Seabed / 2500 meter isobath atlantis's
2500 meter isobath.

 

Notice how parts of the 2500m isobath are smaller contour lines around sea mounts etc. We want to remove
these before we generate the 2500m + 100M constraint line.
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Exercise

Edit the generated 2500m isobath

Clear the display window by clicking the  button in the main toolbar.
In the folder 2. Seabed / 2500 meter Isobath right click atlantis's 2500 meter isobath and
select Edit points and lines...
Click the  button near the bottom of the  dialogue box in order toDisplay Edit points and lines
see the isobaths.
Select the  tab.Delete
Inside the  tab, select  tab.Delete By closed line
Click the  button, then digitize a closed polygon around the part you want to delete byStart
clicking with the left mouse button.
Click  in order to connect the last digitized point with the start point.Connect to Start and End
Click The part inside the closed polygon is now deleted.Delete points INSIDE. 
Change the drop down menu from to Save as an extra copy Overwrite input dataset.
In order to store the changes in the  menu, click the  button atEdit points and lines Execute
the bottom.
Click  to close the  menu.Cancel Edit points and Lines

Clear the display window by clicking the  button in the main toolbar.
In the folder  right click and2. Seabed / 2500 meter Isobath atlantis's 2500 meter isobath 
select the  and confirm that the unwanted parts have been removed.Display
The command stored the original 2500m isobath as a backup. RightEdit points and lines 
click this dataset and select Delete.
Click OK

 

Sometimes when editing a dataset the geodetic settings are lost and we need to set the geodetic metadata for
the dataset.

Exercise

Set geodetic metadata

In the folder  right click and2. Seabed / 2500 meter Isobath atlantis's 2500 meter isobath 
select Properties.
Click the tab Geodetics 
Click Set geodetic meta data
Select  and  (all values 0)World Geodetic System 1984 Mercator
Click OK
Click Close

 

We can now generate the last constraint line

Exercise

Generate 2500m isobath + 100M constraint line

In the folder 2. Seabed / 2500 meter Isobath right click atlantis's 2500 meter isobath and
select Generate 100M Line.
Keep the default settings and click Execute.
The new line should now be available under . Click 1. Maritime Lines / 100M Lines OK.
Click to close the menu. OK 
In the folder 1. display  Maritime Lines / 100M Lines atlantis's 2500 meter isobath + 100M.

-
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Bathymetric Profiles

To determine the foot of the continental slope we need bathymetric profiles. These profiles will be used as input
to the foot of slope analysis tool in the next chapter. Bathymetric profiles can be imported from single beam or
generated from bathymetric grids. In this tutorial we will use the atlantis seabed surface grid (similar to Etopo1)
to generate bathymetric profiles. The project already contains several bathymetric profiles grouped into different
areas. Our task is to complete the foot of slope analysis in region called East Sea. In this section we will
generate the bathymetric profiles, give them a proper name and group them into a folder.

East Sea is the area in red

 

Exercise

Generate a bathymetric profile from a grid

Display the  seabed surface dataset in and zoom in to the East Seaatlantis 2. Seabed / Grids 
area.
Right click the seabed surface dataset again and select the command atlantis Generate

.  A menu will appear.Bathymetric Profile
Click the  button, then digitize the first point of the profile by clicking with the left mouseStart
button where you want the profile to start on the seafloor in the display window.
Digitize the last point of the bathymetric profile by clicking with the left mouse button where
you want the profile to stop on the seafloor.
Click Stop
You will be prompted with a dialog asking you to provide a name for the profile. Keep the
default name and click .OK
Geocap will notify you where the resulting Bathymetric profile has been stored in the
project. Click .OK
Locate the new profile in This is the default position of2. Seabed / Bathymetric Profiles. 
bathymetric profiles.
Display the profile.

To ensure the most accurate calculation of the foot of slope the bathymetric profiles should run
perpendicular to the seabed surface contours.

It is possible to generate a bathymetric profile following a specific path or feature by digitizing more than
two points.
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Exercise

Generate more bathymetric profiles in the East Sea area

Repeat the steps in the previous exercise and generate a few more profiles in the same area. You
should have 3-5 profiles in the area.

 

We should now group our bathymetric profiles into a folder and give them a proper name.

Exercise

Group your bathymetric profiles into a folder

Right click the folder  and select .2. Seabed / Bathymetric Profiles New > Folder
Select  and type in the name Generic East Sea.
Click .OK
Right click the folder and select East Sea Set Schema > Bathymetric Profiles
Locate the profiles you generated in 2. Seabed / Bathymetric Profiles.
Select all the profiles, right click and select Cut
Right click the new folder and select  The profiles are now moved into theEast Sea Paste.
new folder.

Exercise

Rename your bathymetric profiles

Right click one of the profiles in the folder and select  East Sea Rename.
Type in the name East Sea 1.
Click OK
Continue to rename the other profiles in the same manner.  etc.East Sea 2

It is smart to name the profiles so the number increases with the profiles location south to
north.
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E. Foot of Slope Analysis & Hedberg points

Introduction

UNCLOS Article 76 states that "the foot of the continental slope shall be delineated as the point of maximum
FOS analysis is crucial because both formula lines (Gardiner and Hedberg)change in the gradient at its base". 

are calculated using FOS positions. In Geocap there are several tools for analyzing the gradient of the slope,
based on different data sets. The is often used for identifying the approximate locationGradient Band Analysis 
of the base of slope region, based on bathymetric grids. To calculate the accurate location of a foot of slope
(FOS) point the  panel is used. Bathymetric Profile Analysis

In this section we will analyze one foot of slope point for each of the bathymetric profiles we created in the
previous section. Then we will proceed to generate 60M lines (Hedberg) from these FOS points.

Exercises

Visualizing gradient bands
Analyze a bathymetric profile and create a FOS point
Analyze and create FOS points for the remaining bathymetric profiles in the East Sea area
Change an analysis and FOS point
Display FOS points
Investigate the FOS point table view
Joining FOS points into one FOS group dataset
Generating 60M line to the FOS points
Investigate the FOS + 60M table view
Import a bathymetric profile
Save an adjusted bathymetric profile as a new bathymetric profile
Smoothen the bathymetry

Base of Slope

Paragraph 3 of article 76 states that "The continental margin comprises the submerged prolongation of the land
mass of the coastal State, and consists of the sea-bed and subsoil of the shelf, the slope and the rise. It does

This means that the base ofnot include the deep ocean floor with its oceanic ridges or the subsoil thereof". 
slope region is the transition region from the rise to the deep ocean floor. We can try to analyze and visualize
this transition zone using the Gradient Band Analysis. 

The  command will divide a grid into different areas depending on the steepness of theGradient Band Analysis
grid. The areas will be display as color bands. It is possible to adjust the boundaries between the different areas.
The boundaries are set in degrees.

Exercise

Visualizing gradient bands

In the folder  right click  and select  2. Seabed / Grids atlantis Advanced Display > Gradient
Band Analysis
Set the  to Smoothing steps 5
Keep the rest of the settings as default and click Execute.
Investigate the color bands and the steepness. Are the boundaries reasonable? 
Try to change the angles and click Execute. 
Can you find values that could represent the shelf, slope, rise and the deep ocean floor in the 
East Sea region?
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Gradient Band Analysis

Foot of Slope Analysis

The Analysis Panel is one of the most important tools in Geocap because it allows you to determine the Foot of
the Continental Slope in accordance with UNCLOS Article 76.  

The elements of the FOS analysis panel

Important elements in the FOS analysis panel:

The   button lets you select the area you are interested in analyzing. The FOS point will end upSelect area
inside this area.
The  is where you set up the mathematical methods and variables that goCalculate change in gradient 
into the FOS point calculation.
The  lists the possible FOS points in the area. The point with the larges change inSelect Foot of Slope 
gradient will be listed at the top and selected by default.
The  list the different elements in the plot. Elements can be turned on and off or edited. It is alsoPlot item 
possible to add additional elements.
The  button lets you save an analysis and the corresponding FOS point.Save Analysis As... 

A typical workflow for analyzing a foot of slope point would be:

Select an area of interest - This should represent your base of slope region.
Select a method for calculating the gradient - Observe the difference for the three methods.
Select a calculation interval - These values should represent the general trend in the area. 
Save the Analysis and FOS point.

 

Note that the Gradient Band Analysis only takes morphological data into account. Geological and
geophysical data can also be used to identify the base of slope region.
For more information refer to the Scientific and Technical Guidelines of the Commission on the Limits of
the Continental Shelf found here: http://www.un.org/Depts/los/clcs_new/commission_guidelines.htm 

http://www.un.org/Depts/los/clcs_new/commission_guidelines.htm
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The analysis and FOS point will be stored under the bathymetric profile

Profile, Analysis and FOS point

Exercise

Analyze a bathymetric profile and create a FOS point

In the folder  right click the  profile the2. Seabed / Bathymetric Profiles / East Sea East Sea 1
and select The profile analysis tool will appear at the bottom of your screen.Analyze Profile. 
The same profile is also visible in the 3D window above the analysis panel where you will
notice the red vertical line marking the maximum change of gradient.
Click the  button.Select area
Press the left mouse button in the profile window, drag the mouse to the side, and release the
button. You have now selected the area where the software will find the FOS point.
Try increasing the  on both sides (  and ) by typing in a higherCalculation interval blue green
value (i.e 25 000).
When you think you have identified the FOS point. Click the  button. Save Analysis as..
Keep the default name for the Analysis and click OK.
Type in the FOS name and click ES 1  OK.
The FOS point is now saved. Click OK
Click the triangle (or plus sign) next to the  profile in the project and you will seeEast Sea 1
that the FOS analysis is stored as a child of the profile in the tree.

Click the  next to the  dataset, and you will see the triangle (or plus sign) FOS analysis ES
 foot of slope dataset. This is the data set holding the foot of slope point we just made.1  

Click the  button in the Profile Analysis Panel to close it.Exit

Exercise

Analyze and create FOS points for the remaining bathymetric profiles in the East Sea
area

In the folder  right click the next  profile 2. Seabed / Bathymetric Profiles / East Sea East Sea
the and select Analyze Profile.
Use the analysis panel to find the FOS point and click Save Analysis as..
Keep the analysis name and type in the FOS name ES <number corresponding to

and clickbathymetric profile>  OK
Click the Exit button in the Profile Analysis Panel to close it.
Follow the steps above until you have an analysis and FOS point for all bathymetric profiles in
the East Sea area.

-

It is possible to display polygon or other lines which crosses the bathymetric profileBase of slope (BOS) 

in the profile window.  will beClick the  icon on the analysis panel, browse in the line or polygon and it
displayed as a vertical line.
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In many cases you want to go back and look at the analysis you did for a specific FOS point and maybe change
the analysis and update the FOS point. In the next exercise we will change the FOS point for an existing
analysis.

Exercise

Change an analysis and FOS point

In the folder  expand the  profile so 2. Seabed / Bathymetric Profiles / East Sea, East Sea 1
you can see the FOS analysis dataset.
Right click the  dataset and click This will open the profile with theFOS analysis Analyze. 
settings you used for this analysis.
Change some of the settings in the analysis in order to move/change the FOS point. (i.e
selected area, calculation interval, method)
Click Save Analysis changes
This will overwrite the previous settings. Click OK
Click  to close the analysis panelExit

Exercise

Display FOS points

In the folder expand the  profile and 2. Seabed / Bathymetric Profiles / East Sea East Sea 1

analysis so you can see the  dataset.ES 1

Right click  and select ES 1 Display FOS points.
Notice that the FOS point is displayed as a sphere in the graphics window.
Repeat the steps above to display all your FOS points in the East Sea area.

Exercise

Investigate the FOS point table view

In the folder expand the  profile and 2. Seabed / Bathymetric Profiles / East Sea East Sea 1

analysis so you can see the dataset.ES 1 

Right click   and select ES 1 Table View. 
Notice that the various field data contains the information from the analysis panel.
Click Close

-
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Generating Hedberg points (FOS + 60M)

Once we have our FOS points we can generate the 60M Hedberg points which is one of the formula lines in
article 76. It is possible to generate a 60M circle around each FOS point but it is often useful to work with a
group of FOS points instead of working with them individually. The next exercises will show you how to collect
many FOS points into one foot of slope dataset and then generate 60M Hedberg points around those FOS
points.

 

Exercise

Joining FOS points into one FOS group dataset

In the folder expand the  profile and 2. Seabed / Bathymetric Profiles / East Sea East Sea 1

analysis so you can see the dataset.ES 1 

Right click  ES 1 and select This will open a menu with a listMerge Foot of Slope Points. 
containing your first FOS point. We are now going to populate this list with the rest of the FOS
points.

Keep the menu open and select the dataset in your project. Click the  icon in theES 2 
merge menu. This will add the FOS point to your list.
Repeat the previous step to add all your FOS points in the East Sea area to the list.

In the folder 2. Seabed / Foot of slope select the folder and click the  ico Region Groups 
n in the merge menu to select the  folder.Result
Click .Execute
Type in the name  and click This will store your FOS group in the East Sea OK. Region

 folder.Groups
Click to close the menu. Cancel 
In the folder 2. Seabed / Foot of slope  right click and click / Region groups East Sea  Displa
y FOS points.

 

We are now going to create the Hedberg lines from these FOS points.

Exercise

Generating 60M line to the FOS points

In the folder 2. Seabed / Foot of slope  right click  and click  / Region groups East Sea Gener
ate 60M Line.
Keep the default settings and click .Execute
The new line will be stored in Click1. Maritime Lines / 60M Lines.  OK.
Click  to close the menu OK
In the folder  right click and click 1. Maritime Lines / 60M Lines  East Sea + 60M  White
(FOS+60).

 

The Table View contains important metadata about the Hedberg points.

Exercise

Investigate the FOS + 60M table view

In the folder  right click and click 1. Maritime Lines / 60M Lines  East Sea + 60M  Table View.
Notice how the  changes as you scroll down the list of points.FOS Point Name
Click Close

-
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Real Bathymetric Profiles

Real bathymetric profiles are measured, usually by sonar. They are not generated by extracting values from a
seabed grid or from any other data derived mainly from satellite altimetry, such as ETOPO1. An example of real
bathymetry is "Corrected Depth Bathymetry" from the U.S. National Oceanic and Atmospheric Administration's
(NOAA) Geophysical Data System (GEODAS). Bathymetric profiles often come in ASCII formats with X Y Z or
Lat Lon Z values. These type of files can be imported using the ASCII importer in Geocap. In the next exercise
we are going to import a bathymetric profile using this import menu.

 

Exercise

Import a bathymetric profile

In the folder  right click and click  2. Seabed / Bathymetric Profiles Singlebeam Import >
ASCII Column.

Click the button and browse for the dataset called  Cruise-12  (Data/Atlantis/Bathymetry/Si
nglebeam/Cruise-12.txt). Click Open
Make sure  is set toAdjust header  0
Make sure  is set toCoordinate format  XY
Make sure is checked Z 
Make sure is unchecked Scalars 
Make sure that  = , = , =File column X 1 Y 2 Z 3
Make sure that  is set to Cell type Line
Make sure that is set to Schema Bathymetric Profile
Click Execute
You will be prompted with a dialog asking you for Coordinate System and Datum. Select Worl

 and  (all values 0)d Geodetic System 1984 Mercator
Click OK 
The file is now imported Click.  OK
Click  to close the import menu. OK

 

The GEODAS bathymetric profiles can sometimes be very long, covering areas that you are not interested in. In
addition to this they can contain noise etc. It is possible to adjust the length of the profiles in Geocap, so that you
will only analyse the part you need. It is also possible to filter/smoothen the data. We are now going to adjust the
length of the profile we just imported and then use filters to smoothen it.

Exercise

Save an adjusted bathymetric profile as a new bathymetric profile

In the folder 2. Seabed / Bathymetric Profiles / Single Beam right click  and click Cruise-12
.Analyze

In the 3D graphics window find the white spheres at the end of the profile and adjust them by
dragging the spheres to the desired position.
In the bottom left corner of the analysis panel click on Save profile As...
Type in the name  and click Cruise-12-East-Sea OK 
The new profile will be saved in the same folder as the original. Click OK. 
Click analysis panel. Exit to close the 
Right-click the new bathymetric profile in your project and click  Notice theAnalyze Profile. 
new bathymetric profile is now a sub-set of the original profile.

Tip
In some instances the white spheres may be very small when the analysis panel is first opened. It may
be necessary to zoom in closer to find one of the ends of the profile. Once the white sphere is clicked on
once, the white spheres on both ends will become larger and easier to see when dragging them to the
desired position.
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The bathymetry in the Cruise-12 singlebeam dataset is very "choppy" for some reason, and we want to
smoothen the datset,

Exercise

Smoothen the bathymetry

In the analysis panel check the box in front of Notice that a thin yellow line is shown1.Filter. 
on top of your seabed in the analysis window.
Change the filter to e.g. Gliding Average
Try changing the number and observed the difference in the filteredCalculation point radius 
line
Try to find a FOS point you think you can justify and save the analysis by clicking Save
Analysis As
Give the FOS point a proper name and click OK
Click again OK 
Click  to close the analysis windowExit

 

 

As a general rule we do not recommend filtering and smoothing of bathymetric profiles unless it is
absolutely necessary. If you do use filtering in an FOS analysis the Commission might request full
disclosure of the original data, the mathematical details of the smoothing algorithm and the output data. 
For more information refer to section 5.3 in the Scientific and Technical Guidelines of the Commission
on the Limits of the Continental Shelf found here: http://www.un.org/Depts/los/clcs_new/commission_gui
delines.htm 

It is possible to store the filtered (e.g. smoothed) bathymetry as a separate datset. Click the Tables of
 button to the right in the analysis panel . The filtered result is then available in a tab, and may bevalues

extracted as a project dataset.

http://www.un.org/Depts/los/clcs_new/commission_guidelines.htm
http://www.un.org/Depts/los/clcs_new/commission_guidelines.htm
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F. Sediment Thickness Grid & 1% distance to FOS

Introduction

Sediment thickness plays an important role in UNCLOS article 76, since it is used to define the Gardiner formula
points. These are points where the thickness of sedimentary rocks is at least 1 per cent of the shortest distance
to the foot of the continental slope.

NOAA/NGDC provides a sediment thickness grid of the Worlds Oceans here: http://www.ngdc.noaa.gov/mgg/se
. This dataset is very coarse and will not be accepted by the Commission. It is however adthick/index.html

dataset which can provide you with an overview of where you might potentially have enough sediments to use
the Gardiner formula. 

In this section we will use a sediment thickness grid to identify areas where there might be enough sediments to
identify Gardiner points. Then in the next section we will take a closer look at seismic data in order to calculate
the sediment thickness more accurately.

Exercises

Display Sediment Thickness Grid
Calculate 1% of the distance to the closest FOS point

Sediment Thickness Grid

 

Exercise

Display Sediment Thickness Grid

In the folder right click and click 3. Sediment Data / Grids Sediment Thickness Map Data
The grid displayed shows thickness in meter and has no reference to depth. Blue is the
thickest part while red is the thinnest part.
In  display all your Hedberg points.1. Maritime lines / 60M lines
Try to identify an area where you might have enough sediments.

Calculate 1% distance to FOS

In the next exercises we are going to identify the areas of the grid where the thickness is more than 1% of the
distance back to the closest foot of slope point. Geocap can calculate this in one operation taking all FOS points
into account.

Exercise

Calculate 1% of the distance to the closest FOS point

In the folder right click and click 3. Sediment Data / Grids Sediment Thickness Generate
>1% dist to fos Area

In the menu that pops up, click the  icon and browse for the dataset Northern Plateau 
in the folder. 2. Seabed / Foot of slope / Region Groups 
Make sure that  is  Store in project unchecked.
Click Execute
Click  to close the menu OK
The area displayed has a thickness which is more than 1% of the distance back to one or

more of the foot of slope points in the datasetNorthern Plateau .

 

In the next section we will take a closer look at the area in the north.

http://www.ngdc.noaa.gov/mgg/sedthick/index.html
http://www.ngdc.noaa.gov/mgg/sedthick/index.html
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G. Seismic Interpretation

Introduction

In order to accurately calculate the sediment thickness we have to interpret the seabed surface and the base of
sediments on seismic lines. In Geocap these two layers are called horizons. The distance between the seabed
and basement horizons is the sediment thickness. 

When collecting seismic data a seismic wave travels from its source to a given reflector and returns to a receiver
at the sea surface. T two way travel time. In most cases this will be the depth unit (inhe elapsed time is called 
milliseconds) of your seismic. Since the seismic is in time (milliseconds) and we need to calculate the sediment
thickness in meters we need to do a conversion. This is called a depth conversion. The formula itself is simple:

The difficult part of the formula is finding the correct speed/velocity model, since theDistance = Speed * Time. 
velocity changes through the different layers in the subsurface. In Geocap the interpretation is normally done in
the time domain. This gives us the flexibility to change the velocity model and just update the sediment thickness
calculation accordingly. We will have a look at different velocity models in the next section.

Illustration of a marine seismic survey using a towed streamer

In this section we will visualize seismic data, import seismic and interpret seismic.

Exercises

Display a seismic line
Display the interpretation
Interpret the Seabed
Interpret the Sediment Base
Import SEG-Y files
Auto track the Seabed
Complete the Sediment Base interpretation

Display Seismic Lines and Interpretation

 

Exercise

Display a seismic line

In the folder  right click the seismic line a3. Sediment Data / Seismic Data / ATL-99 ATL-99-1 
nd click Seismic Display
In the folder  right click the seismic line 3. Sediment Data / Seismic Data / ATL-LOS-00 ATL-

and click LOS-00-1 Seismic Display
Investigate the seismic lines. Can you identify the Seabed and Sediment Base?
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Exercise

Display the interpretation

In the folder  right click the Ihorizon  and3. Sediment Data / Seismic Interpretations Seabed
click IHorizon Display.
In the folder  right click the Ihorizon 3. Sediment Data / Seismic Interpretations Sediment

 and click Base IHorizon Display.
Investigate the interpreted horizons. Notice that there is only interpretation for the first line.

Interpret Seismic Lines

In the next exercises we are going to complete the interpretation of the Seabed and Sediment Base for the
seismic line ATL-LOS-00-1. 

Exercise

Interpret the Seabed

Go to . This is the interpretation system in GeocapTools > Seismic Interpretation
Select  folder: Click the  button, select the folder Interpetation Browse  Seismic Interpretation
and click OK
Select  Click the  button, select  and click Ihorizon: Browse Seabed OK

Select the : Click the  button and click on the seismic line ATL-LOS-00-1 inSeismic
the display window (with your left mouse button)

Keep the rest of the settings as default and click the  button.
Zoom to where the yellow line ends on the previous line and start to pick points on the seismic
line by pointing the mouse cursor on the seabed and pressing the  key on the<space>
keyboard. Press  to undo a pick.d

When you want to stop, You canclick the  button. This will save the interpretation. 

continue to interpret the seabed by clicking the  button again.

When you are done with the seabed, click the  button.

 

We are now going to interpret the Sediment Base but before we can do this we need to change the Ihorizon we
are interpreting on.

Exercise

Interpret the Sediment Base

Change  Click the  button, select  and click Ihorizon: Browse Sediment Base OK

Keep the rest of the settings and click the  button.
Zoom to where the blue line ends on the previous line and start to pick points on the seismic
line by pointing the mouse cursor on the sediment base and pressing the  key on the<space>
keyboard. Press  to undo a pick.d

When you want to stop, click the  button. This will save the interpretation. You can

continue to interpret the sediment base by clicking the  button again.

When you are done with the sediment base, click the  button.
Click on the Seismic Interpretation menu.Close 

Your interpretation should look something like this when you are finished:

You do not have to delete parts of the interpretation if it is wrong. Just re-interpret the part that is wrong

and Geocap will automatically update the Ihorizon when you click .
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Seabed and Sediment Base interpretations

Import Seismic Lines

There is one more seismic line in this area but it has not been imported yet. In the next exercise we will import
this line and then continue to interpret it.

The format for seismic lines is SEG-Y. This format was developed by the Society of Exploration Geophysicists
(SEG) in 1973. Since then format has evolved in to many different "flavors", which sometimes makes it difficult to
import. When importing a SEG-Y file it is important to set the byte positions correctly. If you are lucky there might
be some information about the byte positions in the EBCDIC header, and if you are even luckier the default
settings in Geocap will be correct.  

This exercise will not go into details on seismic/SEG-Y import. It will cover the simple case for a plain SEG-Y file
 If you have problems importingwhich follows the SEG-Y standard and has navigation stored in the trace header.

a SEG-Y file at a later stage, please contact support@geocap.no

 

Exercise

Import SEG-Y files

In the folder  right click the folder  and click3. Sediment Data/Seismic Data  ATL-LOS-00  Imp
. The SEG-Y import menu will appear.ort > SEG-Y 2D

Click the  button in order to reset the menu to the default options.Defaults

Click the  button and select the -file located in the Atlantis folderATL-LOS-00-2.sgy
structure on disk ( ). Click .Data/Atlantis/Sediment Data/ATL-LOS-00-2.sgy Open
Look at the information in the and see if the information matches the importEBCDIC header 
settings.
Click Geocap will investigate the SEG-Y file.Scan.  
Click the tab. Investigate the range of the file and that the coordinates, shot pointScan results 
range etc. looks correct.
Click Execute
You will be prompted with a dialog asking you for  and  for the seismic line.datum projection
Select  and  and click WGS 84 Mercator 0 OK
Click  againOK
Click in order to close the SEG-Y import command.OK 
In the folder  right click the seismic line 3. Sediment Data / Seismic Data / ATL-LOS-00 ATL-

and click LOS-00-2 Seismic Display
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Interpret Seismic Lines continued

We are now going to complete the interpretation of the Seabed and Sediment Base on the seismic line
ATL-LOS-00-2. This seabed on this seismic line is very flat and has a strong continuous reflector. This lets us
use the auto tracker to automatically interpret the seabed.

Exercise

Auto track the Seabed

Go to . This is the interpretation system in Geocap.Tools > Seismic Interpretation
Select  folder: Click the  button select the folder Interpetation Browse , Seismic Interpretation 
and click OK.
Select  Click the  button, select  and click Ihorizon: Browse Seabed OK

Select the : Click the  button and click on the seismic line ATL-LOS-00-2 inSeismic
the display window (with your left mouse button)
Change the  to Snap mode Min
Change the to Track mode  Auto

Keep the rest of the settings and click the  button.
Zoom in close to the seabed, point the mouse cursor anywhere on the seabed and press the <
space> key. This will automatically interpret the seabed.
Zoom out and see if the whole seabed was interpreted. If not, continue to press the <space> k
ey where it is missing interpretation.

When the whole seabed has been interpreted, click the  button.

 

We are now going to interpret the Sediment Base on the seismic line ATL-LOS-00-2.

Exercise

Complete the Sediment Base interpretation

Change  Click the  button, select  and click Ihorizon: Browse Sediment Base OK
Change the  to Snap mode Off

Click the  button.

Complete the sediment base interpretation and click 
Close the seismic interpretation menu when you are done.

The seabed and sediement base interpretation for all lines should look something like this:

Seabed and Sediment Base interpretations
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H. Depth Conversion & Thickness Calculations

Introduction

In order to use the sediment formula criterion in UNCLOS Article 76, we need a data set containing the sediment
thickness; a sediment profile. The seismic lines interpreted in the previous section is stored with milliseconds as
a z coordinate, not meters. In order to compute a sediment thickness in meters, we need to do a depth
conversion. In this section we will cover the basics for working with velocities, depth conversion and sediment
thickness calculation.

Exercises

Import a velocity data set
Assign navigation to the velocity datasets
Display the Stacking Velocities
Convert stacking velocities to interval velocities
Generate velocity profile from seismic interpretation using interval velocity dataset
Generate a sediment profile
Display the sediment profile
Inspect the table view of the sediment profile

Velocities

Velocities are often provided as ASCII column files. The file should contain the shot point, time, and velocity. The
file may also contain coordinates. In our training data set, there are no coordinates, therefore we need to assign
navigation from a navigation data set. If the file contains velocities from more than one line, it should also have a
column with the line name.

Exercise

Import a velocity data set

In the folder  right click the folder and click3. Sediment Data / Velocities  Stacking Velocities  
Import > Stacking Velocities (no navigation)

Click the  button and browse for the data set called (ATL-LOS-00.vel Data/Atlantis/Sedime
) Clicknt data/ATL-LOS-00.vel .  Open.

Adjust the columns according to the screen shot below by clicking up or down in the spin box.
Click Execute.
You will be prompted with a dialog asking you to specify  and ClicDatum Coordinate System. 
k All Undefined.
The dataset has been imported. Click OK
Click on the  import menu. OK  Stacking Velocity
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Stacking Velocity import menu

 

The data sets have now been imported into your project. However they do not yet hold any coordinates. In order
to visualize the stacking velocities with the seismic data, we need to assign navigation to the velocities. Geocap
will use the shot point number in the velocity data set and match them with the shot points in a navigation file.
Either a separate navigation file, or the actual seismic line can be used as source of navigation.

Exercise

Assign navigation to the velocity datasets

In the folder  right click the velocity3. Sediment Data / Velocities / Stacking Velocities
dataset and clickATL-LOS-00-1  Assign Navigation.
Browse for the seismic line  in the and click ATL-LOS-00-1  Seismic Data folder  OK.
In the folder  right click the velocity3. Sediment Data / Velocities / Stacking Velocities
dataset and clickATL-LOS-00-2  Assign Navigation.
Browse for the seismic line  in the and click ATL-LOS-00-2  Seismic Data folder  OK.

 

The velocity data sets are now in the right location and can be displayed together with the seismic data.

Exercise

Display the Stacking Velocities

In the folder  right click the velocity3. Sediment Data / Velocities / Stacking Velocities
dataset and clickATL-LOS-00-1  Map Data.
In the folder  right click the velocity3. Sediment Data / Velocities / Stacking Velocities
dataset and clickATL-LOS-00-2  Map Data.
Display the two seismic lines in the folder 3. Sediment Data / Seismic Data / ATL-LOS-00.
Investigate the velocity data together with the seismic data.

 

If you have imported stacking velocities or RMS velocities, we need to convert them to interval velocities using
Dix formula before we can use them to generate velocity profiles. Dix formula will use the stacking velocities as
an approximation for RMS velocities and produce interval velocities.
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Exercise

Convert stacking velocities to interval velocities

In the folder  right click the folder and click 3. Sediment Data / Velocities Stacking Velocities 
Compute Interval Velocities (Dix Formula)
The result will be stored in the folder Clic 3. Sediment Data / Velocities / Interval Velocities. 
k OK.

 

Velocity Profiles

We now need to calculate the average velocity from the seabed down to the sediment base, along the seismic
lines. To do this we have to generate velocity profiles.

Exercise

Generate velocity profile from seismic interpretation using interval velocity dataset

In the folder  right click the folder and click3. Sediment Data / Velocities  Velocity Profiles  Ge
nerate Velocity Profile.

Click the first  icon and browse in the seismic data folder and click ATL-LOS-00 OK.

Click the second  icon, browse in the folder  and click  Seismic Interpretations OK.
Make sure  is set to Match points by: Shot Point.
Make sure is set toUse interval velocities from:   Dataset in Project.

Click the icon, browse in the  folder and click Interval Velocities   Interval Velocites  OK.
Leave the rest of the settings as default and click Execute.
In the menu that pops up make sure that both lines are checked and click OK
The result is stored in the folder 3. Sediment Data / Velocities / Velocity Profiles
Click  to close the menu. Cancel

 

Depth conversion and thickness calculation

The next step is to perform the depth conversion and calculate the sediment thickness. In Geocap this can be
done in one operation by generating a sediment profile. The velocity profile holds all the data necessary to do
this.

Exercise

Generate a sediment profile

In the folder 3. Sediment Data / Velocities right click the folder Velocity Profiles and click Ca
lculate Sediment Thickness.
In the menu that pops up make sure that  as been selected. Calculate Sediment Thickness
Click Execute.
The result will be stored in in  Click 3. Sediment Data / Sediment profiles. OK.
Click to close the menu OK 

If you do not have velocity data available it is possible to use a velocity look-up table or formula. See
documentation for more information.
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Exercise

Display the sediment profile

In the folder  right click the sediment thickness profile3. Sediment Data / Sediment profiles  A
and clickTL-LOS-00-1  Display profile as Cross Section

In the folder  right click the sediment thickness profile3. Sediment Data / Sediment profiles  A
and clickTL-LOS-00-2  Display profile as Cross Section

Try displaying the  seabed grid also and compare it with the sediment profiles.atlantis

Exercise

Inspect the table view of the sediment profile

In the folder 3. Sediment Data / Sediment profiles right click the sediment thickness profile A
TL-LOS-00-1 and click Table View
Inspect the different columns. The ,  and  is the position and the seabed depth at thatX Y Z
point. The   value is the sediment thickness in meters. The Shot point column is theScalar
points corresponding shot point from the seismic line.
Click to close theClose  Table View
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I. Gardiner Points

Introduction

In the previous section we calculated sediment thicknesses. In order to apply the sediment thickness formula
(Gardiner) in UNCLOS Article 76, we need to compare the sediment thickness with the distance to the foot of
slope. When working with 1% sediment thickness points it is often useful to experiment with different datasets
and settings. You might for example change the velocity model and see how that effects the final Gardiner
points, or you might try to change the FOS points to see if that has any effect on the final result. In this section
we are going to experiment with different percentages, instead of looking just at 1%, and see how much this
affects the calculations.

Exercises

Display sediment thickness points > 1% of distance to FOS
Use different percentages to calculate x% sediment thickness points
Store the 1% sediment thickness (Gardiner) points
Examine the metadata for sediment thickness points

 

Visualizing 1% sediment thickness points

The  command uses a FOS dataset as input to the calculation. ThisGenerate > 1% of distance to FOS Area 
can be a single FOS point or a group of many FOS points. Geocap will automatically find the FOS point which is
closest to any sediment thickness point and then do the 1% calculation. Since all our profiles are located in the

Northern Plateau we know that our  FOS points will be the closest, so we will use thisNorthern Plateau 
dataset.

Exercise

Display sediment thickness points > 1% of distance to FOS

In the folder right click the profile  and3. Sediment Data / Sediment Profiles ATL-LOS-00-2
click Generate > 1% of distance to FOS Area.

Click the  icon, browse for the  dataset and click Northern Plateau OK.
Make sure the  is checked.Display as cross section
Uncheck the box.Store in project 
Click Execute.
Examine the result. Points thicker than 1% of the distance to the nearest FOS point will display
the sediment profile in . Points less than 1% distance to FOS is displayed in .green red

Sediment profile showing thickness more (green) and less (red) than 1% of the distance back to FOS

 

You now have a set of Gardiner points, but what would happen if you changed your interpretation, velocity
model or FOS points? What is the uncertainty of the sediment thickness? An easy way of visualizing how
"stable" your Gardiner points are is to change the percentage of distance to FOS.
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Exercise

Use different percentages to calculate x% sediment thickness points

Change the to Percentage of distance to FOS 1.1%
Keep the rest of the settings and click Execute.
Investigate the result. Did it change? In which direction? Why?
Change the Percentage of distance to FOS to 0.9%
Keep the rest of the settings and click Execute.
Investigate the result. Did it change? In which direction? Why?

Saving 1% sediment thickness points

We now want to store our Gardiner points as a separate dataset so we can continue to work with them.

Exercise

Store the 1% sediment thickness (Gardiner) points

Change the back to Percentage of distance to FOS  1%
Check the box Store in project
Make sure  is checked Display as cross section
Click Execute. 
A new data set will be created in  Click 3. Sediment Data / Sediment Thickness Points. OK.
Repeat the process for all sediment profiles.
All profiles should now be displayed with green and/or red colors representing more than 1%
sediment thickness and less than 1% sediment thickness.

 

The 1% sediment thickness (Gardiner) points datset conatins a lot of relevant metadata, like which FOS point
was used in the calculation, the exact percentage, the shot point, the distance in meters etc. This is information
that should be documented in the final submission.

Exercise

Examine the metadata for sediment thickness points

In the folder  right click the G3. Sediment Data / Sediment Thickness Points  ATL-LOS-00-2 
ardiner points and click Table View
Observe that that each 1% sediment thickness point refers back to a bathymetric profile and a
FOS point. It also reports the thickness, shot point, distance in meters and percent of distance
to FOS.
Identify the Gardiner point furthest away from the coastline, it should be the last one in the
table. Tip: Check the box and select the last point in the table.Display marked points 
Which FOS point contributed to this Gardiner point? What is the percentage of the distance
back to this FOS point?

It is also possible to look at the uncertainty of your sediment thickness by increasing or decreasing it with
i.e 10%. This can be done using the  command and multiplying the sediment thickness pointsFunction
with  or 1.1 0.9.
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J. Final Outer Limits

Introduction

UNCLOS Article 76 states that "The coastal State shall delineate the outer limits of its continental shelf, where
that shelf extends beyond 200 nautical miles from the baselines from which the breadth of the territorial sea is
measured, by straight lines not exceeding 60 nautical miles in length, connecting fixed points, defined by
coordinates of latitude and longitude."

At this point we have created all the formula lines and constraint lines and we can proceed to construct the final
outer limit. The construction of outer limits is a complex operation but the   tool is designedGenerate Outer Limit
to assist you in the best possible way. The tool lets you digitize and combine line segments and keep distances
between points less than 60M. Sometimes it is best to do this area by area and in multiple steps, then combining
points into one or more final outer limits. In many cases the best approach is to construct and outer edge line
consisting of only Hedberg points, Gardiner points and the 200M line, and then construct a constraint line
consisting of the 350M line and the 2500m + 100M isobath. These two lines can then be combined into one final
outer limit.

In the exercises in this section we will try to produce a final outer limit using the  tool.Generate Outer Limit 

Exercises

Copy your data to the Outer limit folder
Get familiar with the Outer Limit Menu
Digitize the outer edge
Investigate the Outer Edge Limit line metadata
Optimize the Outer Edge Limit
Digitize the constraint line

The Outer Limit Menu

Before we can use the  tool we need to populate the  folder withGenerate Outer Limit  4. Outer limit 
the necessary data. If you look at the folders inside the outer limit folder you will see three folders called; Constr

and We need to copy our distance lines, Hedberg points and Gardiner points intoaints, Formulae  Outer Limit. 
these folders.

Exercise

Copy your data to the Outer limit folder

In the folder  right click and click1. Martime lines / 200M lines  Baseline_Atlantis + 200M  Co
py.
In the folder right click the folder and click4. Outer limit  Formulae  Paste.
In the folder select all the lines, right click and click1. Martime lines / 60M lines ,  Copy.
In the folder right click the folder and click4. Outer limit  Formulae  Paste.
In the folder select all the lines, right click a3. Sediment Data / Sediment Thickness Points , 
nd click Copy.
In the folder right click the folder and click4. Outer limit  Formulae  Paste.
In the folder  right click a1. Martime lines / 100M lines  atlantis's 2500 meter isobath + 100M 
nd click Copy.
In the folder right click the folder and click4. Outer limit  Constraints  Paste.
In the folder  right click and click1. Martime lines / 350M lines  Baseline_Atlantis + 350M  Co
py.
In the folder right click the folder and click4. Outer limit  Constraints  Paste.

All necessary data should now be in one of the folders in the Outer limit folder.

 When digitizing the outer limit it is possible to activate different datsets to be available during the construction of
the outer limit. We can now take a closer look at the Outer Limit Menu.
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Exercise

Get familiar with the Outer Limit Menu

Right click the folder and click 4. Outer limit Generate Outer Limit
Observe the different datasets and folders in the menu.
Check the box next to the  folder.Formulae

Click the  icon at the top of the menu to display all the activated datasets.

The Outer Limit Menu

-
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Digitize the Outer Limit

We can now start to digitize the outer limit. We will do this in three steps; first digitize the outer edge consisting
of formula lines, then digitize a constraint line consisting of the distance constraints, and then finally combine
these two lines.

The digitizer has a range of different keyboard shortcuts that you need to use when constructing an outer limit:

left click (mouse) - will snap to the closest point on any line. 
c - crossing lines - will insert a new point between two lines, or a line and the 60NM circle. 
d - delete - will delete the last digitized point.
l - connect to line - will insert a new point on the line at the cursor position.
s - select line piece - will select all the points on a line until next crossing line or to end of line. 
m - multiple selection - will select all points from previous point to picked point (mouse cursor location)

 

For the first exercise we have included a screen shot of the steps in the exercise.
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Exercise

Digitize the outer edge

Click the  button.Start Digitize
Snap to a point on the 200M line by placing your mouse cursor over the line in the East Sea
area and clicking the left mouse button.
We are now going to follow this line north until we meet the crossing 60M line. Place your
cursor close to the crossing between the 200M line and the 60M line and press on thes 
keyboard.
We now want to follow this  line until me meet the next crossing 60M line. 60M Place your
cursor close to the crossing between the 60M line we are at and the next 60M line and press s
Again we want to follow this  line until me meet the next crossing 60M line, but we want to60M
make sure it follows the outer part of the 60M line. Place your cursor somewhere on the outer
part of the 60M line and press m.
Follow the line to the next 60M crossing line by placing your cursor close to the crossing
between the 60M line we are at and the next 60M line and press s.
We now want to follow this 60M line until me meet the crossing 200M line. Place your cursor
close to the crossing between the 60M line we are at and the 200M line and press s
We now want to follow the 200M line until me meet the crossing 60M line again. Place your
cursor close to the crossing between the 200M line and the crossing 60M line and press s
We now want to follow this 60M line until we can reach the sediment thickness points. Place
your cursor further up on the 60M line and press m
When you can see the sediment thickness points inside the white circle you can connect to
them by clicking the Tip: place the cursor outside the point furthest out toleft mouse button. 
snap to the "maximum" point.
Continue to click the until you are passed the sediment thickness area. left mouse button 
We now want to connect to the 60M line in the north. Place your cursor close to the crossing
between the 60M line and the white 60M circle and press c.
We now want to follow this 60M line until me meet the crossing 200M line, but we want to
make sure it follows the outer part of the 60M line. Place your cursor somewhere on the outer
part of the 60M line and press m.
Follow the line to the 200M crossing line by placing your cursor close to the crossing between
the 60M line and the 200M line and press s.
We now want to follow this 200M line a little bit further to the west. Place your cursor
somewhere to the west on the 200M line and press m.
Stop digitizing by clicking End Digitize
You will be asked to specify a name. Type in and click Outer Edge Limit  OK
The dataset is stored in click 4. Outer limit / Outer Limit OK
Click to close the Outer Limit Menu Close 

 

The digitized outer limit lines contains a lot of important metadata which will be used in the documentation. Each
point on the outer limit line will refer back to the original FOS point or basepoint. It also contains information on
point distance, shot point, sediment thickness and a lot more.

Exercise

Investigate the Outer Edge Limit line metadata

In the folder  right click  and click4. Outer limit / Outer limit  Outer Edge Limit  Table View.
Look at the information in the different columns and scroll down the list of points.
Click when you are done.Close 

 

One important part of the outer limit line definition is that it should consist of: straight lines not exceeding
60 nautical miles in length, connecting fixed points. This means we can bridge some of the concave areas of the
Outer Edge Line to gain more area
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Exercise

Optimize the Outer Edge Limit

In the folder  right click  and click4. Outer limit / Outer limit  Outer Edge Limit  Optimize outer
limit
Keep the default settings and click The result will be stored in the same folderExecute. 
Click  to close the menuOK
In the folder  right click and click4. Outer limit / Outer limit  Outer Edge Limit Optimized  Dis
play
Investigate the areas that have been bridged.

 

We are now going to digitize the constraint line. It is important to remember that we want to select the constraint
line which is furthest out at any point. 

Exercise

Digitize the constraint line

Make sure the graphics window has been cleared by clicking 
Right click the folder and click 4. Outer limit Generate Outer Limit
Check the box next to the  folder.Constraints

Click the  icon at the top of the menu to display all the activated datasets.
Click the  button.Start Digitize
Digitze the constraint line using a combination of your mouse and keyboard short cuts.
Click End Digitze
You will be asked to specify a name. Type in and click Constraint Line  OK
The dataset is stored in click 4. Outer limit / Outer Limit OK
Click to close the Outer Limit Menu Close 

 

Finally we can produce the final outer limit.

Exercise Continued

Make sure the graphics window has been cleared by clicking 
Right click the folder and click 4. Outer limit Generate Outer Limit
Check the box next to the two datasets  and Outer Edge Limit Optimized Constraint Line

Click the  icon at the top of the menu to display all the activated datasets.
Click the  button.Start Digitize
Digitze the final outer limit line using a combination of your mouse and keyboard short cuts.
Click End Digitze
Keep the default name and click  OK
The dataset is stored in click 4. Outer limit / Outer Limit OK
Click to close the Outer Limit Menu Close 

 

 

The tool is based on angle calculation and not area calculation. The angles areOptimize outer limit 
calculated in what ever coordinate system the data is in. Thus, It cannot be assumed this tools will
automatically produce the absolute maximum achievable area.
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K. Basic Concepts in Geocap

Introduction

There are a few concepts in Geocap which are important to understand in order to work efficiently with the
software. The main concepts are ,  and These concepts willActors Schemas, Geodetic Settings Commands. 
be explained in this section. In addition to this section also talks about toolbars, color tables and keyboard short
cuts.

Exercises

Create an item command
Get familiar with schema commands
Change the default display for seabed surfaces
View the geodetic settings of a dataset
Change the color table on a seabed surface
Display data on the Sticky Surface
Try out the different tools on the toolbar
Try the different keyboard shortcuts

Actors

In display context an   is a graphical term for a visualization unit. A complex display is created by a set of actor ac
.  are shown as child's of datasets and are shown in blue text. In Geocap the basic principle is that ators Actors

display   creates one or several . It is possible to remove the  and the associated displaycommand actors actors
by right clicking and selecting Delete

Visualizations are called actors

Schemas

By default datasets are organized into data types, such as points and lines (polydata), grids (structured points)
etc. These are basic geometric types that contain little information about the domain in which they operate. E.g.
coast lines, bathymetric profiles and boundary polygons are all lines (polydata), but the way we work with these
types of data are very different and so it is only natural to classify them into different categories. This higher level
of classification is made possible by . schemas

Notice that the dataset types are the same, while the schemas are different

The Shelf Module contains several schemas. Some of the schemas used in the Shelf Module are  , coast line ba
,  ,  ,  . You can define the schema of a dataset in the projectse line limit line seabed surface sediment thickness

by right clicking it, and selecting   in the pop-up menu. The choice of a dataset´s schema controlsset schema
which commands you see in the pop-up menu when you right click the dataset. You may create your own
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schemas as well as edit existing schemas by selecting   under edit in the main menu. You can also editschemas
the commands associated with the schemas.

Commands

Commands are operations which can be performed on a dataset. Commands can for example be used to
display a dataset in the display window, or to generate new datasets. You can even create your own scripted
commands to cater to your specific needs. You execute a command by right clicking the dataset or folder you
want to run it on, and then selecting the relevant command in the pop-up menu.

Commands have two execution modes:   and  . If the execution mode is set to   theDirect Interactive Interactive
commands editor with the front menu will be displayed when you execute the command. This allows you to
adjust various settings that define how the command works. Depending on the command, the menu will consist
of different input settings from simple display settings to complex manipulation options. If the execution mode is
set to   the command will execute with the last active input settings for the command. It is possible to seeDirect
the underlying settings for any command by right clicking it in the  and selecting .Note that someToolbox Edit
commands does not require input parameters and will therefore display the underlying code when running it in In

 mode.teractive

All commands have a front end panel, and most of them have settings that may be customized.

 
 An example of a command front end panel

Commands can be stored in three categories:

Item commands
Schema commands
Shared commands.

You will find the commands sorted into the different categories in the   or on the right-click menu of aToolbox
dataset or a folder. Commands can also be put together in sequence in   to perform visualizations orWorkflows
data operations.

Item commands

An item command is associated with a single dataset or folder in the project. Item commands are stored along
with the project. Therefore, if a project is transferred the item commands will transferred as well. Item commands
typically contain settings that pertain specifically to the dataset to which it belongs.

To see if a command is set to  or  mode, look behind the command name. If there areDirect Interactive
ellipsis ( ) behind the name, the command is set to  mode.... Interactive
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Exercise

Create an item command

Go to  and select one of the datasets.1. Maritime lines / 60M lines
In the  right click and selectToolbox Display  Edit.
Set  to .Line Width 4
Check  and set the color to .User defined Color Red

Click the  icon in the upper right corner of the menu and observe that the command
appears in the  under .Toolbox Item Commands
Click  (the settings will not be saved for the schema command).Cancel
Right click the  command under  and select .Display Item Commands Rename
Rename it to and click .Display in red OK
Select the different lines in  and observe that the new 1. Maritime lines / 60M lines Display in

 command is only available for the one dataset.red

Schema Commands
A schema command is stored with a schema. All datasets or folders using the same schema share these
commands, which also means that editing these commands will affect all the datasets using this schema. The
schema commands are listed on the right click menu and in the   under . Toolbox Schema commands

Exercise

Get familiar with schema commands

Right click the different datasets in the project, and see how the right click menu changes from
schema to schema.

Shared Commands
Shared Commands are commands which are shared with all datasets and folders. These commands are always
available and listed in the  under . Toolbox Shared commands

 

Default Commands
The default command is the command that is executed when you tick the box next to a dataset in the project.
By default a dataset will have one of the schema commands as a default command. This can however be
changed to any command.

 

Exercise

Change the default display for seabed surfaces

The seabed surfaces has a default command "Map sea" or something similar.

Click on the  datasets in the  folder.Seabed 2.Seabed / Grids
In the right-click another command (i.e ) and selectToolbox LOD Grid Display  Set as default
command
Tick the checkbox next to the  dataset and notice that the new command is executed.Seabed

-

Tip
The  check box lets you decide which commands should be available in the right clickPin to Menu
menu, so it is easy to keep organized.  Try to experiment with this option to manipulate the right click
menu.
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Geodetic settings

In Geocap it is the responsibility of the user to secure that data have the correct   and Datum Coordinate system
, also called a  or . Datasets with the same geographical location but with differentProjection  Geodetic settings
coordinate system will not be displayed in the same location in the graphical window. Thus, you will need to
convert one of the datasets to the other coordinate system.

 

Exercise

View the geodetic settings of a dataset

Right click any dataset in your project and click Properties
Click on the tab Geodetics 
Observe the Geodetic settings of the dataset
Read the warning message
Click Close

You will learn how to convert datasets to other projectons later in this tutorial.

Color Tables

Geocap comes with a set of predefined color tables which can be seen in the toolbox. These color tables are of
course customizable, or you can create your own color table from scratch. By default the color tables shown in
the lower right corner of Geocap will be used to display a dataset. You can change these color tables by
selecting one of them, right-click another color table in the toolbox and select  . Activate You can also drag color
tables from the toolbox and drop it onto a displayed dataset in the graphical window.

Exercise

Change the color table on a seabed surface

Visualize a seabed surface
Click on the tab in the Color Tables Toolbox

,  and  one of the color tables on the seabed surfaceClick drag drop

Sticky Surface

Geocap has a concept where any surface can be set to be . When a surface is sticky, data like points,sticky
lines or images may be displayed onto that surface. This is mainly done by re-sampling lines and displaying
them a little bit above the sticky surface. When a surface is activated (or set) as a sticky surface, it is copied to
workspace under the name .sticky_surface

Exercise

Display data on the Sticky Surface

Right-click on a Seabed surface dataset and select  Set as sticky surface
Select a line, e.g.  in your project.1. Maritime lines > 200M lines > Baseline_Atlantis + 200M
In the Toolbox under  right-click  a .Commands > Schema commands Display nd click Edit
Check the  and press .Glue to Sticky Surface Execute
Investigate the line display
Uncheck the  and press  again and observe the difference.Glue to Sticky Surface Execute

Warning
Note that points and lines displayed onto a sticky surface are displayed without their original z-values,
and this may not be what you intend to do when displaying a foot of slope point or a bathymetric line.
Keep that in mind.
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Toolbar

 - Will cancel any mouse action that is started but is regretted and should be ended without any operation.

 - Start a mouse action that when clicked on a graphical object will delete that object.

 - Start a mouse action that when clicked on a graphical object can set appearance parameters for that
object. The appearence parameters are: Opacity, Reflection, Diffusion, Ambience.

 - Start a mouse action where the user is supposed to click on a surface that is map with scalar values. The
mapping range of the scalar values according to the color table can then be adjusted.

 - Start a mouse action that when clicked on a graphical object will highlight the corresponding data object in
the project.

 - Start a mouse action where the user can click and draw a rectangle around displayed data and Geocap
will list all dataset names and locations.

 - Will delete all graphics in the current viewport or window (if the window holds only one viewport). The
corresponding references to actors in the project are deleted. Frequently used in free interactive work.

 - Will delete the last graphical object (also called and actor) that is displayed. Frequently used to erase a
graphical object that shall be removed. Note: Redisplaying data from the project using the same command will
erase the previous corresponding actor.

 - Will set the graphical window in 2D mode; i.e. only pan and zoom is allowed. The view direction (x, y or z)
depends on the corresponding setting. In 2D mode the left button on the mouse is used for immediate cursor
response for instance in digitizing

 - Will set the graphical window in 3D mode; pan, zoom and 3D rolling is enabled. The default 3D mode
renders in perspective view; i.e. parallel lines are not parallel on the screen, but shows a perspective. 

 - Will turn the z direction of the graphical window upwards; i.e. the positive direction of the z axis points
upwards.

 - Will turn the z direction of the graphical window downwards; i.e. the positive direction of the z axis points
downwards. This is the default case because most surfaces are below the zero level, but still have positive z
values.

 - Will show the graphical window as a frame box. It is important to use this icon to check the graphical
window or whenever some display comes out weird if the display algorithm uses the graphical window to set
display parameters.

 - Will draw default axes for all visible axes directions. No tick marks are display for simplicity, but the exact
location of an annotation position starts at the beginning of the annotation.

 - Will open a Navigator which is a convenient menu for navigating a 3D graphical scene. To some
(especially newbies) it can be difficult to use the mouse buttons to orientate the graphics. Be aware that rotation
is around the focal point which also can be set by pointing the cursor mouse at a any location on a solid object
and push keyboard x.

 - Will zoom in towards the focal point. The graphical window is not changed, although the graphical frame
may lie out the visible part of the screen.

 - Will zoom out from the focal point.

 - Will View from above. This icon also contains sub-icons for viewing in other directions.

 - If several windows are created on the same Tab, this icon connects the selected windows to the same
visual camera. Very useful when different surfaces that shall be compared are displayed in separate windows
that are connected and show the same under all graphical movements.
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 - Will show the viewport menu that allows for a quick way to create viewports inside a window. The number
and layout of the viewports are determined by just double clicking on the lower right frame in the veiwport menu.
If the viewports are connected they can also by used for simultaneously display of surfaces or features that shall
be compared. 

 - Enables the light source to be moved around in the graphical scene. Will create shadows and highlight
features. Usefull for presentation graphics and detailed studies of special structures.

 - Will scale the graphical scene with all its actor up or down. Very important for selecting a good view. The
scaling should also preferable be set in the Project Settings so that the preferred view comes up when loading
a project.

 - Will show up a 2D compass in upper right that follows the rotation of the graphical window. Another click
on the icon will remove the compass.

 

Exercise

Try out the different tools on the toolbar

Try out the different tools.

Keyboard shortcuts

Geocap has several  or . Go  shortcuts to bring up a list. Akeyboard shortcuts hotkeys Help > Keyboard
selection of the most important keyboard shortcuts:

Key Explanation Key Explanation

o Toggle color code for last used map command
on/off.

+ Zoom in.

s Turn graphics into surface mode. - Zoom out.

v Value of height/depth (z coordinate) from cursor
position

2 Toggle graphics to 2d mode.

w Turn graphics into wire mode. 3 Toggle graphics to 3d mode.

x Setting the focal point. The graphics will rotate
around this point.

3 Toggle stereo view on/off when stereo is
activated.

y Cursor point is set at the surface of the graphical
element.

z Zoom by drawing a rubber band with left
button on the mouse.

j Snap to any point on a displayed line.    

Exercise

Try the different keyboard shortcuts

Visualize a seabed surface and test all the above mentioned keyboard shortcuts.

When using or to snap to lines or surfaces, Geocap will report what you have snapped to in the lowerj y 
left corner.
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L. Build your own Shelf (UNCLOS) Project

Introduction

We have now been through all the main steps in building a Shelf project, and it is time to look at a real example.
In this section we are going to build a project from scratch in an area you want to look closer at. We are going to
use public data available online or provided by us, analyze them and generating the datsets we needed for a
submission. The first part of this section will mainly be about importing data and converting it to the correct
projection. In the last part we will produce the distance lines, analyze the bathymetry, generate Hedberg points
and Gardiner points and hopefully produce an outer limit.

Exercises

Generate a new and empty UNCLOS project
Download coastline files from the Internet
Import and display the GSHHS coastline files
Convert coast line to the right projection and display
Download the ETOPO1 grid from the Internet
Import the seabed grid
Convert the grid to the right projection and display
Import the sediment thickness grid
Convert the grid to the right projection and display
Generate dummy baseline
Import baseline
Generate the 200M and 350M lines
Clean up the 200M and 350M lines
Generate the 2500m isobath
Edit the generated 2500m isobath
Generate the 2500m isobath + 100M distance constraint
Generate Bathymetric Profiles
Download Bathymetric Profiles from GEODAS
Import Bathymetric Profiles from GEODAS
Analyze your profiles
Group FOS points
Generate 60M Hedberg points
Calculate 1% of the distance to the closest FOS point
Copy your data to the Outer limit folder
Generate the outer limit

The UNCLOS Project Template

Geocap provide empty folder structure for various types of projects. This will give you a starting point to get
organized with your own project. A project template either gives you a ready made folder structure, or it gives
you a suite of folders to choose from.

Geocap can provide an empty folder structure for UNCLOS projects. This will give you a starting point to get
organized with your own UNCLOS project. The default folder structure holds empty folders for most of the data
types you will need. If you do not find a suitable folder you can create a new folder for that data. It is also a good
idea to create sub-folders if you have a lot of data, for example a sub-folder for each survey or for each region.
Other subfolders commonly created are folders for FOS Collections, Images etc.

 

An empty project structure may be used for communicating relevant data to colleagues, or for analysis
and trouble shooting by us. To send parts of a project to us in Geocap Support, even only a single
dataset, you may copy the dataset (or a folder) from your main project and paste it into this empty
project. Then zip and send the disk folder .zip to projectname support@geocap.no
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Exercise

Generate a new and empty UNCLOS project

In the main menu, click File > New > Project
Select UNCLOS project template
In the  field type in  . Project names may consist of letters,Name Geocap_Training_<Year>
numbers and spaces, but special characters like [, æ,ø, å, &, /, % ... should be avoided.
Click the  button, and select where you want to store your project on your hard disk.Browse
Click Finish

An empty Shelf project

The idea is that this basic structure is kept. Folders may be added and data imported, but the original folders
should not be renamed or moved, and their schemas should not be changed. This is because this folder
structure is used when new datasets are generated. If an original folder is not present, it will be recreated.

Import Data

We will now explain the basics of importing datasets and working with coordinate systems in Geocap. Most
datasets in Geocap are imported using the   or the   The   is used toASCII import Generic import. Generic import
import a number of different formats, such as  ,  ,  etc. When browsing in a file, the images grids  shapefiles Gener

 will recognize the file format and let you define an   to import. The   readsic import Area of Interest ASCII import
data from an ASCII file into the Geocap project.   can be used for many types text data files, e.g.ASCII import
whether the data columns have fixed or variable width, and also whether the coordinates are in X Y or Lat Lon.
When data is read into the project, it can be organized in a number of different ways. It is for example possible to
tell Geocap to split the data into different dataset whenever a value in a specific file column changes. There are
also options for creating project folders whenever a column value changes.

We have already used the ASCII import in a previous section so in this section we are going to import different
datasets using the   method and convert the datasets to the projection we want to use in ourGeneric import
project.

Coastline

We are now going to import a coastline file. National Geophysical Data Center (NGDC) provides coast lines
covering the entire world in a data set they call GSHHS (Global Self-consistent, Hierarchical, High-resolution
Shoreline Database). Geocap can read both the raw data format (the files gshhs_*.b files), and the shapefiles
directly. In this exercise we are going to import the *.b files. 

If you have limited  connection you can skip this exercise and continue with the next one since we haveinternet 
provided the dataset already.
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Exercise

Download coastline files from the Internet

Open a web browser and go to this NGDC web page: http://www.ngdc.noaa.gov/mgg/shorelin
.es/gshhs.html

Click .Download GSHHS Data
Download and save the file gshhs_2.3.3.zip (November 1, 2014) 
Uncompress the files to a folder on your hard disk.

Exercise

Import and display the GSHHS coastline files

Locate the folder called  in your Geocap project under .Coast Lines 1. Maritime Lines
Right click the folder and select .Import > Generic…
The format should be set to .Automatic

Click the browse  button and locate the folder with the GSHHS files.
Select the file called  (this is a high resolution, but not the full resolution), and click gshhs_h.b

.Open
Click the  tab.Area of Interest
Check the  check box.Import Area
Type in the minimum and maximum latitude and longitude in decimal degrees.

Max Y = Northern boundary of import area Min X = Western boundary of import area
Max X = Eastern boundary of import area   = Southern boundary of import areaMin Y

Click .Execute
Geocap will recognize the datum and coordinate system of the file and confirm that the file has
been read. Click .OK
After the file has been read, click the  button in the Generic reader dialog.OK
Observe that the imported dataset is stored in the  folder.Coast lines
Right click the dataset and select Zoom to Data
Right click the dataset and select Display

 

The data is imported in Geodetic, with latitudes as Y coordinates and longitudes as X coordinates. In order to
view the data in a proper projection, we convert the data to to the projection we want to use.

Exercise

Convert coast line to the right projection and display

Click the dataset and go to the  section in the .Shared commands Toolbox
Double click the  command you want to use, in the  folder.Convert to... Operations
Define the appropriate settings
Change the result combo box to .Replace input
Click .Execute
Agree to replace the existing dataset by clicking .Yes
The data is now converted. Click OK.
Click to close the conversion menu OK 
Observe that the display is automatically updated to the new projection.

-

http://www.ngdc.noaa.gov/mgg/shorelines/gshhs.html
http://www.ngdc.noaa.gov/mgg/shorelines/gshhs.html
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Global Seabed Grid

ETOPO1 is a 1 arc-minute global relief model of Earth's surface that integrates land topography and ocean
bathymetry. In the next exercises we will download and import this grid into Geocap.

Exercise

Download the ETOPO1 grid from the Internet

Open a web browser, and go to the following address: http://www.ngdc.noaa.gov/mgg/global/g
lobal.html
Click the link:  - in the left column on the page, below the globe. A newExtract Custom Grids
web page with a interactive map should appear.
Zoom into the area where you want to extract the grid.
Click the icon with and in the upper left corner of the map window.i 
Drag a rectangle over the area where you want to extract the grid. You should see a red
rectangle on the map.
Keep Layer as ETOPO1 (ice)
Select Output Format XYZ
Click " "click here to download

Exercise

Import the seabed grid

Locate the folder called  in your Geocap project under Grids 2. Seabed
Right click the folder and select Import > Generic…
The format should be set to Automatic.

Click the browse  button and locate the ETOPO file.
Click the  tab.Area of Interest
Check the  check box.Import Area
Type in the minimum and maximum latitude and longitude in decimal degrees.

Max Y = Northern boundary of import area   = Western boundary of import areaMin X
Max X = Eastern boundary of import area   = Southern boundary of import areaMin Y

Click on the  tab and under polydata and check the box next to  (TheReader Options Invert
grid has negative values for sea depths, and positive values for heights above sea
level. Usually bathymetry data has positive values for depths. We therefore have to multiply
the depth and height values by -1 with this option to "flip" the data).
Click .Execute
You will now be prompted with a question of the coordinate system and datum. Select: World

,  and click .Geodetic system 1984 Geodetic OK
Geocap will report if the grid has been imported correctly; click  and close the import dialogOK
by clicking .Cancel
Observe that the new data set has appeared in the  folder.Grids

 

The data is imported in Geodetic, with latitudes as Y coordinates and longitudes as X coordinates.  In order to
view the grid with the data we have already imported and converted to another projection, we need to convert
this grid to match the same projection as the other data in the project .

http://www.ngdc.noaa.gov/mgg/global/global.html
http://www.ngdc.noaa.gov/mgg/global/global.html
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Exercise

Convert the grid to the right projection and display

Click the seabed grid and go to the  section in the .Shared commands Toolbox
Double click the  command you want to use, in the  folder.Convert to... Operations
Define the appropriate settings
Change the result combo box to .Replace input
Click .Execute
Agree to replace the existing dataset by clicking .Yes
Geocap will report if the grid has been converted correctly, click  and close the conversionOK
dialog by clicking .Cancel
Check that the schema of the dataset is .  If not then right click the dataset,seabed surface
choose  and choose .Set Schema seabed surface
Display the dataset together with the coastline.

 

Global sediment thickness

The Global Sediment thickness can be downloaded as a grid here: http://www.ngdc.noaa.gov/mgg/sedthick/inde
x.html

Exercise

Import the sediment thickness grid

Locate the folder called  in your Geocap project under (you mightGrids 3. Sediment Data 
have to create it)
Right click the folder and select Import > Generic…
The format should be set to Automatic.

Click the browse  button and locate the sediment thickness file.
Click the  tab.Area of Interest
Check the  check box.Import Area
Type in the minimum and maximum latitude and longitude in decimal degrees.

Max Y = Northern boundary of import area   = Western boundary of import areaMin X
Max X = Eastern boundary of import area   = Southern boundary of import areaMin Y

Click on the  tab and make sure  is unchecked.Reader Options Invert
Click .Execute
Geocap will report if the grid has been imported correctly; click  and close the import dialogOK
by clicking .Cancel
Observe that the new data set has appeared in the  folder.Grids

Exercise

Convert the grid to the right projection and display

Click the seabed grid and go to the  section in the .Shared commands Toolbox
Double click the  command you want to use, in the  folder.Convert to... Operations
Define the appropriate settings
Change the result combo box to .Replace input
Click .Execute
Agree to replace the existing dataset by clicking .Yes
Geocap will report if the grid has been converted correctly, click  and close the conversionOK
dialog by clicking .Cancel
Right click the dataset, choose  and choose Set Schema Sediment Thickness
Display the dataset together with the coastline.

-

http://www.ngdc.noaa.gov/mgg/sedthick/index.html
http://www.ngdc.noaa.gov/mgg/sedthick/index.html
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Generate or import a Baseline

The baseline is needed in order to generate distance lines. The coast may also be used as a baseline (by
changing the schema accordingly), but then the computing time may be very long. If you do not have a baseline
for your area, you may generate a dummy to use as an approximation based on the coast line you imported in a
previous exercise.  If you already have imported an official baseline you may jump to the import baseline
exercise.

Exercise

Generate dummy baseline

Display the coast line called GSHHS, which should have been imported in 1. Maritime Lines /
.Coast lines

Open the Digitizer by selecting  from the main menu.Tools > Quick digitizing
Check the option , and click the  button.Save also in folder Browse
Select the  folder under , and click Base lines 1. Maritime Lines OK.
Click Start digitizing.
Digitize the points on the coast line by pressing on the keyboard. The picks will automaticallyj 
snap to the nearest point on the coast line data set. Digitize a rough version of the coast line
by picking the outermost points on the coast line.
When you are finished digitizing click the  button. The digitized line shouldStop digitizing
appear in the  folder.Base lines
Click the  to close the digitizing menu.X
Locate the digitized baseline in 1. Maritime lines / Base lines
Right click the baseline dataset and select .  Rename the data set to your countryRename
name and . Click _baseline OK
Right click the baseline dataset, and select Set Schema > Base line
Right click the baseline dataset, and select Properties > Geodetics
Click and specify your settings. Set geodetic meta data 

Digitizing a baseline

 

If you already have a baseline you want to import you can import it using the ASCII import menu, or Generic
import if you have a Shapefile. The exercise below is for a baseline in ASCII format. If you created a dummy
baseline in the previous exercise you can skip this exercise.

Exercise

Import baseline

Right click the Base lines folder under 1. Maritime Lines and select Import > ASCII Column

Click the  button and browse for your baseline file.
Make sure the is set correctly.Coordinate format, File column, Cell type and Schema 
You may add a column for point name if the file contains point names.
Click  to import the fileExecute
If the coordinates in your file was in Latitude and Longitude you need to convert it to the right
projection.

-
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Generate Distance Lines

We can now proceed to generate the distance lines we need for our project. The 200M line and the 350M line.

Exercise

Generate the 200M and 350M lines

In the folder  right click your baseline and click1. Maritime Lines / Base lines  Generate 200M
line.
Use the settings you want and click Execute.
Generate the 350M line also.

 

Depending on your project area parts of your 200M and 350M lines might be on land or in none relevant areas.
We can clean this up and remove this part of the line using the  command.Edit points and lines

Exercise

Clean up the 200M and 350M lines

Select the 200M line in your project.
Find the command in the You might have to add it by rightEdit points and lines Toolbox. 
clicking a folder in the  and selecting Toolbox New command.
Use the command to delete the part of the line you don`t need.
Do the same with the 350M line if needed.

Distance Constraint

We are now going to create the last distance constraint, the 2500m isobath + 100M.

Exercise

Generate the 2500m isobath

Right click the seabed grid in the folder and click 2. Seabed / Grids Generate 2500m
 Isobath.

The command will generate a new dataset. Click OK

Exercise

Edit the generated 2500m isobath

Clear the display window by clicking the  button in the main toolbar.
In the folder  right click the 2500m isobath and select 2. Seabed / 2500 meter Isobath  Edit

.points and lines..
Use command do delete the parts on the line that we are not going to use as input to generate
the 100M line.
Click  when you are finishedExecute

Exercise

Generate the 2500m isobath + 100M distance constraint

In the folder 2. Seabed / 2500 meter Isobath right click the 2500m isobath and select Genera
te 100M Line
Keep the default settings and click Execute
The command will generate a new dataset. Click OK.

-
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Generate or Import Bathymetric Profiles

Before we start analyzing the foot of slope we need bathymetric profiles. Initially you might want to create
bathymetric profiles from the seabed grid, but you also need real bathymetric profiles. In the next two exercises
we are going to create a few bathymetric profiles from the seabed grid and then import real bathymetric profiles
from GEODAS.

Exercise

Generate Bathymetric Profiles

Display your seabed grid in the folder 2. Seabed / Grids
In the folder  right click your seabed grid and click 2. Seabed / Grids Generate Bathymetric
Profile
Find and area where you want a bathymetric profile and digitize it.
Continue to generate profiles until you think you have enough.
Rename your profiles so they have a useful name

 

In the next exercise we will download a "Corrected Depth Bathymetry" from the U.S. National Oceanic and
Atmospheric Administration's (NOAA) Geophysical Data System (GEODAS) and then import this profile using
the ASCII Column importer in Geocap.

Exercise

Download Bathymetric Profiles from GEODAS

Go to this link: ttp://www.ngdc.noaa.gov/mgg/geodas/geodas.html
Click .Trackline Geophysical Data Viewer
Zoom in to the area you are working in.
Click on a line which you thing would be useful to analyze.
Click on in the popup.Get Marine Data for these Surveys 
On the site that comes up, change the format to  with  as XYZ Z value Bathymetric corrected
depth
Follow the instructions on the site to download the data

Exercise

Import Bathymetric Profiles from GEODAS

Right click the Bathymetric Profiles folder under 2. Seabed and select Import > ASCII
Column

Click the  button and browse for your bathymetric profile.
Make sure the Coordinate format, File column, Z, Cell type and Schema is set correctly.
Click Execute to import the profile
If the coordinates in the profile was in Latitude and Longitude you need to convert it to the right
projection.

-

http://www.ngdc.noaa.gov/mgg/geodas/geodas.html
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Foot of Slope Analysis and Hedberg points

You should now have several bathymetric profiles in your project, and we can proceede to analyze these to find
FOS points.

Exercise

Analyze your profiles

Right click on of the bathymetric profiles under 2. Seabed / Bathymetric Profiles and click An
alyze.
Try out different settings in the analysis window in order to find a FOS point you think the
Commission would accept.
Save the analysis and type in a useful name for your FOS point.
Analyze FOS points for the rest of your bathymetric profiles

 

After you have analyzed all your profiles and created FOS points we will merge the FOS points in order to create
one set of Hedberg points. 

Exercise

Group FOS points

Create a new folder under , called  2. Seabed FOS points.
Right click one of the FOS points you have created and click .Merge Foot of Slope points
Add the rest of your FOS points to the list and set the  folder as result location.FOS points
Click Execute
Type in a useful name for your FOS point group.

 

We are now going to generate the 60M line from the merged FOS points.

Exercise

Generate 60M Hedberg points

In the folder   right click your group of FOS points and click 2. Seabed / FOS points Generate
60M line.
Use the settings you want and click Execute.

Generate Gardiner points

We will now investigate the sediment data in the area and try to generate Gardiner points using the global
sediment thickness grid and the FOS points we just created. Note that there might not be enough sediments to
produce Gardiner points in the area you are working in.

Exercise

Calculate 1% of the distance to the closest FOS point

In the folder right click and click 3. Sediment Data / Grids Sediment Thickness Generate
>1% dist to fos Area

In the menu that pops up, click the  icon and browse for the group of FOS points.
Make sure that  is  Store in project checked.
Click Execute
Investigate the Gardiner points

-
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Create Outer Limit

Now that we have all the relevant data in our project we can proceed to copy all our formula lines and constraint
lines into the Outer Limit folder and generate the outer limit.

Exercise

Copy your data to the Outer limit folder

Copy the , , , 200M line 350M line Hedberg points Gardiner points .
Paste them into the appropriate folder in the folder.4. Outer limit 

Exercise

Generate the outer limit

Right click the folder and click 4. Outer limit Generate Outer Limit
Use the tool to generate your outer limit
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M. Workflows

Introduction

A workflow in Geocap is a way of combining datasets and actions or visualizations in sequence to produce
visualizations, movements and powerpoint style 3D presentations. In this section we will have a look at one of
the workflows provided with the Atlantis project and then we will create a workflow our self. It is up to you if you
want to create a workflow from the Atlantis project or from the new project you built.

Exercises

Examine the workflows provided in the Atlantis project.
Create a new workflow
Build the workflow
Execute the workflow
Create a flight tour

 

Exercise

Examine the workflows provided in the Atlantis project.

Make sure the Atlantis project is open.
In Geocap, click , and browse to the Atlantis project folder, then openFile > Open > Workflow
the the sub-folder called .workflows
Select  and click . This will open the workflow below the project.Basic_Workflow.gwf Open
Examine the contents of the workflow items by clicking on the triangles next to the root folders.

Click on the Go to first executable element   icon and then click on the Execute next

element   icon. (This will initialize the basic display settings and nothing will appear in the
display window yet)

Click on the Execute next element   icon again and notice everything in the Base map fol
der will be displayed.

Continue clicking on the Execute next element   icon until you reach the end of the
workflow and observe how different elements of the Atlantis project are displayed.
Close the workflow by clicking Close

 

Workflows are saved as single files on disk with file extension *.gwf, (Geocap Work Flow). It is a good idea to
store them in a folder called  next to the  folder on diskworkflows db . In the next exercises we will create a new
empty workflow. 

Exercise

Create a new workflow

Go to File > New > Workflow.
Browse for  folder or create a new one.workflow
Give your workflow a name and click Save.
The new empty workflow window will pop up below the project

 

We are now going to add different commands to our workflow. This can be done in different way. You can turn
on the recorder and start executing commands and they will end up in the workflow or you can copy commands

Note that the user may also execute each element one at a time by right clicking on the command and
choosing , see the image below.Execute
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from the Toolbox and paste them into the workflow. You can also add elements from the workflow toolbar.

Exercise

Build the workflow

Select a dataset in your project that you want to display.
In the  right click the display command you want to use in your workflow and select Toolbox

Copy

Click the  button in the workflow. The command will now be opened in edit mode. 
Check the settings and click OK
Continue to add elements to your workflow by selecting a dataset and copying a command
into the workflow.

Exercise

Execute the workflow

Click the  icon.

Click the icon to execute next element or the  icon to execute all elements in the
workflow.

 

A flight tour collects a series of camera positions and moves the camera smoothly through these positions. In
order to create a camera position all you need to do is right click a folder and select New > Camera Position.

Exercise

Create a flight tour

In your project, create a new generic folder called Cameras
Zoom to an area you want to save as a camera position.
Right click the folder  and select Cameras New > Camera Position
Repeat the last two steps to create more camera positions.
Select the  folder in your project.Cameras
In the go to , right click  and selectToolbox Shared Commands > Visualization   Flight Tour  C
opy.
Paste the command into your workflow. The command will open and it should have selected
the  folder as input. Cameras
Set the flight time between every camera position to  seconds and make sure 5 Collect

 and  is checkedcameras in folder to smooth flight tour Single flight tour
Click OK

Select the  command in the workflow and click Flight Tour the icon to run the flight tour.

To update a camera position, set the view in the graphics window, right click the camera
position and select Assign View.

It is possible to group elements in a folder. Add folders by clicking  on theNew workflow element
workflow toolbar and selecting  under Group General .
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N. DataLink for ArcGIS

Introduction

The Datalink for ArcGIS plugin provides interoperability between Geocap and the ArcGIS suite of products from
Esri. The DataLink allows you to open existing ArcMap Documents (.mxd) inside Geocap and lets you display
the data directly in the graphics window of Geocap.

It is also possible to open Esri File Geodatabases inside a Geocap project allowing you to copy data between
the Geocap project and the geodatabase.

 

Exercises

Load an ArcGIS map document the Geocap project
Visualize map data in the Geocap project
Create a new file geodatabase in the project
Copy data from Geocap to the geodatabase

ArcMap documents in Geocap

Exercise

Load an ArcGIS map document the Geocap project

Open the Atlantis project
In the project toolbar click the   toolbuttonAdd Data Source
Click Add Data Source
On the connection dialog type inn a name that describes the map file. This is optional.
In the   field choose Datasource ArcMap Document
Click the Browse button to select the  map fileAtlantis.mxd
Click Connect
A map node will be created in the project. This is a link to the existing mxd file. No data is
copied.

Exercise

Visualize map data in the Geocap project

Select a layer that is not a group layer.
Right click on the layer node 
If the layer is a feature layer use  Display Features
If the layer is a raster layer use  Open the command in edit mode an checkLOD Grid Display.  
Flip Z values.

-

The Datalink for ArcGIS is only available in the 32bit version of Geocap. You will also need an existing
ArcGIS 10.x desktop license to be available on your machine.
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File Geodatabases

 

Exercise

Create a new file geodatabase in the project

Create a new project or open an existing one
In the project toolbar click the   toolbuttonAdd Data Source
Click Create ArcGIS File Geodatabase
The database creation dialog pops up. There are two alternatives for the location of the new
geodatabase:

If you create the database  directory the geodatabase and relative inside the project
path names will continue to work even if you change the location of the Geocap project.
If you create the database   it can more easily be shared by severaloutside the project
projects or other applications, but the database can no longer be accessed by the
project if the project is moved..

Choose the database location and name and click OK
The geodatabase is create on disk and a new database object is created in the project.

Exercise

Copy data from Geocap to the geodatabase

Right-click the dataset that you wish to move to the file geodatabase and select Copy
Right click the geodatabase object and click Paste.
A dialog will pop up showing you various options for tranforming the VTK data to a
corresponding ESRI data format. Which conversion dialog is shown depends on whether the
VTK data format is a raster dataset or polydata. If the source dataset is VTK Polydata the
dataset will be split into two feature classes, one for points and for the the cell geometry. You
may choose one or both. In most cases you will also choose to flip the Z values, which is
default.
Geocap will try to determine the ESRI spatial reference that corresponds to the one in the
source dataset. If you think the chosen suggested spatial reference is wrong you may browse
and select one of the standard ESRI spatial references.
Click    to perform the conversion and close the dialog OK
The result data will be found in the project  under the geodatabase connection.
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O. Image Georeferencing

Introduction

This tutorial will guide you through the process of georeferencing a map. To georeference a map or image you
need 3 tie points. These points should cover as much of the map as possible. The map in this exercise has a
graticule showing latitude and longitude which works great as tie points.

Exercises

Import an image into your project
Georeference an image

 

Exercise

Import an image into your project

Create a  folder (i.e. a folder with schema Generic) and rename that folder to Generic My
Maps
Right-click the  folder and go to . Browse for a *.jpg or a *.png.My Maps Import > Generic
Make sure the schema of the image set to .Image Data
Make sure  is unchekedSpecify import area
Click Execute

Exercise

Georeference an image

Right click the image you want to geo reference and select Geo Reference
A new window will show the image and the georeference menu will pop up in the lower left
corner.
In the first menu specify the original spatial reference of the map. In this case  and WGS84 Mer
cator
Click next
In the  drop down select Tie point Coordinate Format 12°34.56' N/S
Type in the values  and Lat: 32 00 S Lon: 13 00 W
Zoom into this crossing point on the map
Click on  and click on the crossing graticules in the map. Image pick
Select  in the drop down listTie point 2
Type in the values  and Lat: 32 00 S Lon: 1 00 W
Zoom into this crossing point on the map
Click on  and click on the crossing graticules in the map Image pick
Select  in the drop down listTie point 3
Type in the values  and Lat: 20 00 S Lon: 1 00 W
Zoom into this crossing point on the map
Click on  and click on the crossing graticules in the map Image pick
Once you have georeferenced three tie points the table will provide you with an pixel error.
The value should not exceed more than 1 pixel on each point.
Click  to complete the georeferencingFinish
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P. Vertical Image Calibration

Introduction

This tutorial will guide you through creating a vertical calibrated image (VCI) from an old
scanned seismic image. The process can however be performed on any image. All you
need are two datasets:

Image
Navigation

We assume you have already imported the image and navigation (or digitized a
navigation line).
 

Open VCI menu

The VCI menu is opened from  . The menuView > Vertical Image Calibration (XCal in older Geocap versions)
should appear in the same panel as your project, like the screen shot below:

This menu consists of 3 steps (tabs) that you need to complete in order to complete the vertical calibration.

Input/Output

Click the  browse button and select the  where your image resides.Image folder
Select the image you want to vertically calibrate in the drop down box.
Click the  browse button and select the  where your navigation/digitized line resides.Navigation folder
Select the navigation/digitized line you want to vertically calibrate against in the drop down box.
Click the  browse button and select the  where you want your vertically calibratedResult folder folder
image to be stored.

Vertical Calibration

The  uses a cut off range and 3 calibration points. The cut off range usually starts at 0 andvertical calibration
stops at the max depth/time of your seismic image. Everything above or below this cut off range will be
eliminated from the VCI. The 3 calibration points specify the orientation and scale in vertical direction.

Click the  tab to start the vertical calibration.2. Vertical Calibration
Set the  value in the  to the max time/depth in your image.Stop Vertical Cut Off Range
Set the first calibration point to , click the  button and click on the corresponding value to the left in0 Pick
your image.
Set the second calibration point to the stop value in your cut off range, click the  button and click onPick
the corresponding value in the middle of your image.
Set the third calibration point to , click the  button and click on the corresponding value to the right in0 Pick
your image.
Use the  buttons to zoom closer to each point and re-pick them for a more accurate selection.Focus

You should now see two white horizontal lines across your image. One at 0 depth and one at max depth.

If you want to keep parts of the image above 0 or below the max depth of the seismic image you can do
it by adjusting the cut off range after you have set the calibration points. In the example above we could
set the cut off start to -100. This would preserve the well-information at the top of the image.
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Navigation Calibration

Click the 3. Navigation Calibration tab to start the navigation calibration
Locate the first shot point in your image and find the corresponding shot point in the Tie Points list in the
menu.
Select the Tie Point in the list, then click the Pick button and click on the shot point in the image.
Locate the last shot point in your image and find the corresponding shot point in the Tie Points list in the
menu.
Select the Tie Point in the list, then click the Pick button and click on the shot point in the image. You
should now see a line of points along the shot point line.
Continue this process with the points between the start and end points if needed.

Note that everything to the left and right of the dotted line and everything above and below the white lines will be
cut off on the completed VCI.

Click the  button in order to create the VCISave

Display

Locate your VCI in your result folder.

Right-click the VCI dataset and select  Display
 

 

It is possible to do seismic interpretation on the vertical calibrated image. Just open the Tools > Seismic
Interpretation panel and pick the Vertical Calibrated Image instead of Seismic.

It is possible to convert a VCI to a seismic by "Convert to Seismic". Then the result may be exported as
a SEG-Y.
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Q. Other Topics

Introduction

Shelf and Geocap in general contains a lot more functionality than we have been through in these tutorials. This
section highlights some of these topics.

Exercises

Maritime Zones plugin

Maritime Zones plugin extends the Shelf package with additional capabilities for calculating maritime zones. It
works directly with ArcGIS feature classes and can calculate any maritime zone from both normal and straight
baselines. The calculation also extracts critical points for each zone and store them in a feature class. More
information here: https://geocap.atlassian.net/wiki/display/ug/Maritime+Zones+plugin

Equidistance lines and weighted midlines

It is possible to create equidistance lines and weighted midlines between nations. The command is available on
the base line schema. 

Composed grids

It is possible to combine grids of different resolution into a composed grid and then produce bathymetric profiles
from the composed grid.
More information here: https://geocap.atlassian.net/wiki/display/art/Composed+grids

Area Generator

The   is an automatic project generator that is used to chop out portions of the world from aArea Generator (AG)
database of global or regional data. Select an area by latitude and longitude, select data to include, select datum
and coordinate system and click one button to automatically produce a Geocap project. More information here: 

 -> www.geocap.no/doc Geocap Extensions

Graphic Export

The graphics window in Geocap can be exported to a range of different formats. Select File > Save graphics
as.
It is also possible to copy the graphics window to clip board using and then pasting into powerpoint etc.Ctrl + C, 

Scripting

It is possible to create your own commands and scripts in Geocap.
More information here:  https://geocap.atlassian.net/wiki/display/ug/Scripting+commands+with+a+menu

The Function command

The Function command enables you to manipulate datasets in many different ways. You can find this command
in the  folder.Operations

 

 

https://geocap.atlassian.net/wiki/display/ug/Maritime+Zones+plugin
https://geocap.atlassian.net/wiki/display/art/Composed+grids
http://www.geocap.no/doc
https://geocap.atlassian.net/wiki/display/ug/Scripting+commands+with+a+menu
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